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About This Guide

The SX.25 Administrator’s Guide explains how to use gx25adm to configure X.25 network
connections on a Silicon Graphics™ host. The gx25adm utility is a graphical interface to
5X.25, the Silicon Graphics implementation of the X.25 protocols specified by the
International Consultative Committee for Telegraphy and Telephony (CCITT).

The audience for this guide is experienced X.25 network administrators. The guide
describes gx25adm software components and briefly reviews X.25 network concepts to
familiarize you with the SX.25 operating environment. It assumes that you will consult
CCITT publications and service providers specifications to determine detailed
configuration requirements of your site.

Most procedures in this guide assume that you are configuring an SX.25 host for the first
time. If you are modifying an existing SX.25 configuration, you need to make slight
adjustments when carrying out some instructions. For example, data entry fields that
appear empty on unconfigured systems frequently contain data if the system is already
configured, and it is not necessary to supply configuration data as instructed, except to
make changes. Configured SX.25 hosts might also contain user-created files in addition
to the factory-shipped files; any user-created files are displayed as selections in file lists.

What This Guide Contains

This guide comprises eight chapters and one appendix. It covers these configuration

topics:

Chapter 1, “Understanding the SX.25 Application”
Reviews X.25 network fundamentals, describes the software
components thatimplement SX.25, and summaries gx25adm menus and
their relationship to the underlying software. Read this chapter to
identify the X.25 features that SX.25 offers and to preview the gx25adm
configuration utility.

XV
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XVi

Chapter 2, “Planning for SX.25”

Explains SX.25 port-naming conventions and how to evaluate
factory-shipped parameter files, which eliminate the need to specify
protocol parameters individually. This chapter also contains an
extensive list of the information that you should be prepared to supply
during configuration procedures. Read the chapter before starting the
configuration process to ensure that the process goes smoothly,
particularly if SX.25 is new to the host.

Chapter 3, “Getting Started With gx25adm”

Explains how to start the gx25adm utility and describes the options
available from the menus on the primary window. It also illustrates the
steps in a typical port configuration procedure. Read this chapter for
help with starting a gx25adm session.

Chapter 4, “Configuring a Host for Basic Connections”

Contains procedures for configuring WAN and LAN ports for basic X.25
connection services and for rebuilding the IRIX " operating system
kernel, which is needed to put the ports into operation. Use this chapter
as a tutorial until you become familiar with the port configuration
process.

Chapter 5, “Configuring X.25 Options”

Contains procedures for configuring the optional features that SX.25
offers. Usually, the procedures in this chapter are performed after
Chapter 4 procedures.

Chapter 6, “UUCP Configuration”

Explains how to modify UUCP configuration files to implement UUCP
over the basic connection service. Use the information in this chapter
after you configure the basic connection service (Chapter 4).

Chapter 7, “Creating Customized Parameter Files”

Contains procedures for creating customized protocol parameter files.
Use this chapter in conjunction with Chapter 4 only if you determine
that SX.25 factory-shipped parameter files are not suitable for your
network service.

Chapter 8, “Troubleshooting”

Explains SX.25 error messages and identifies the likely source of the
message. Use this chapter to monitor SX.25 and detect problems with its
operation.
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Appendix A, “Address Formats”
Explains formats for constructing X.121 addresses and Internet
Addresses.

Conventions Used in This Guide

These type conventions and symbols are used in this guide:
Bold Literal command-line arguments, such as options and flags

Italics Executable names, filenames, IRIX commands, manual and book titles,
new terms, and onscreen button names

Fi xed-wi dth type
Error messages, prompts, and onscreen text.

Bol d fixed-wi dth type
User input, including keyboard keys (printing and nonprinting)

“"rr

(Double quotation marks) Onscreen menu items and references in text
to document section titles

0 (Parentheses) Following IRIX commands, surround reference page (man
page) section numbers

# IRIX shell prompt for the superuser (root)

% IRIX shell prompt for users other than superuser

Related Documentation

These documents contain additional information that is related to using SX.25:
*  5X.25 User’s Guide

® 5X.25 Release Notes

e [RIX Admin: System Configquration and Operation

e [RIX Admin: Software Installation and Licensing

See also the online reference pages (man pages): dlpi(7), lictemplate(4), llc2(7), lltune(1M),
snetd(1M), snetd.options(4), and x25addr(5).

XVii






Chapter 1

Understanding the SX.25 Application

SX.25is a STREAMS implementation of the X.25 network standard recommended by the
CCITT. Silicon Graphics workstations and servers running SX.25 can establish virtual
circuit connections to other hosts in X.25 wide area networks (WANSs) or local area
networks (LANs) that operate by CCITT standards. In addition to this basic connection
service, SX.25 also supports PAD, Transmission Control Protocol/Internet Protocol
(TCP/IP), the UNIX®-to-UNIX Copy Program (UUCP), and a network layer interface for
developing custom applications.

SX.25 implements these CCITT recommendations:

e X.3/X.28/X.29 packet assembler/disassembler program (pad).

e X.25Level III, ‘80, ‘84, and ‘88 versions. The ‘84 and ‘88 versions support basic
(modulo 8) and extended (modulo 128) packet sequence numbering.

e X.25Level I LAPB, ‘80, ‘84, and ‘88 versions. The ‘84 and ‘88 versions support basic
and extended packet sequence numbering.

SX.25 also supports the following functions:

e ISO 8208 support for DTE-DTE operation

¢ DTE and DCE operation

e [P to X.25 encapsulation (IXE)

e LLC-2 over IEEE 802.3, used to run X.25 over the LAN

e virtual call (VC) and permanent virtual circuit (PVC) services

* per-call facilities
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X.25 Network Fundamentals

X.25 is a communication protocol for LANs and WANs that comprises a series of
functional layers. Each layer operates in a prescribed way, implementing its own
protocol. Because layer functions are standardized, equivalent layers of other protocols
can be substituted for X.25 layers, increasing the services that the network offers (see
Figure 1-1 for an illustration of the protocol layers as implemented by SX.25). The
combination of protocol layers implementing a particular network function is referred to
as a protocol stack.

Data is exchanged across an X.25 LAN or WAN by means of packet switching. Networks
that implement the X.25 protocol are referred to as packet-switched data networks
(PSDNSs), or more generally as public data networks (PDNs). Although many widely
known PDNss are public networks, such as the European telephone and telegraph
agencies, many PDNs are private service providers, such as Tymnet in the United States.
PDNs offer a commercial service to the organizations or individuals who subscribe to
them.

The CCITT published a series of technical specification for packet switching (the X series)
in 1976, 1980, 1984, and 1988. These specifications came to be known as the X.25
recommendations. Most public and private X.25 network service providers conform to
the 1980, 1984, or 1988 X.25 recommendations. The International Organization for
Standards (ISO) has also published X.25 protocol standards: ISO 8208 specifies the
standard for packet-level functions, and ISO 7776 specifies the standard for link-level
functions (see Figure 1-1).

How Packet-Switched Networks Work

On packet-switched networks, transactions in which users on one host obtain services on
another host are known as calls. During a call, the local and remote hosts operate as data
terminal equipment (DTEs): each DTE performs the functions required to send and
receive data. Data circuit-terminating equipment (a DCE), to which each DTE is attached,
performs the network interface functions that are required, such as establishing and
maintaining connections and performing signal conversions (modem functions).

The line connecting an X.25 host to the network is assigned a network user address (NUA)
that is used to direct call packets to the host. Hosts with more than one line connected to
a network (or multiple networks) require an address for each line. The X.121 standard
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defines X.25 address formats and is used by the majority of PDNs (see Appendix A for
format information).

Virtual Circuits

A connection between a calling DTE and a responding DTE is known as a virtual circuit.
One or more virtual circuits can be sustained on a channel, and several channels may be
allocated to each physical line on a host. Switched virtual circuits (SVCs) handle calls to an
address that the user specifies; SVCs terminate when the call is complete, freeing the
channel capacity for other calls. Permanent virtual circuits (PVCs) are dedicated to calls
between two designated addresses. PVCs do not use DCE services, but they require the
exclusive use of a dedicated channel.

Logical Channels

When a user initiates a call to a remote X.25 host, the DTE assigns the call a logical channel,
identified by a logical channel number, over which the call is conducted. The responding
DTE also assigns a logical channel number for the call, which might be different from that
on the calling DTE. Because each DTE includes the call’s logical channel number in all
packets that it sends, the DCE is able to route the data to its correct destination.

Two-way channels support the flow of data in the inbound and the outbound direction.
X.25 networks also support permanent channels for PVCs and one-way channels that
allow data flow in a single direction: permanent incoming channels and permanent outgoing
channels. The rate at which DTE channels transmit data determines their throughput class.

Packet Types

The function that a packet performs determines the format and contents of the packet. In
general, X.25 communications require three types of packets: call request packets, data
packets, and call termination packets. The calling DTE and responding DTE have their
own version of each packet type. For example, the equivalent of a call request packet (on
the calling DTE) is a call accept packet (on the responding DTE).

When the calling DTE sends a call request packet to initiate a call, the responding DTE
sends a call accept packet to agree to the connection; the virtual circuit is established at
this time. If the call request packet contains a set D-bit (delivery confirmation bit), the
responding DTE acknowledges each data packet that it receives. When the D-bit is not
used, the window size determines the number of packets that can be sent without a
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confirmation. When a call is complete, the calling and responding DTE exchange
clear-request packets to terminate the virtual circuit.

Either DTE may send interrupt packets to transmit urgent information. The data flow is
normally resumed after the interrupt sequence is processed. By contrast, reset packets,
which reset the virtual circuit, sometimes clear all data and interrupt packets from the
circuit. For this reason, DTEs transmit reset packets only in unusual circumstances.

Packet Sizes

The maximum size of network packets is set by the X.25 version that a network uses: the
1980 recommendation sets the maximum packet size to 1024 bytes, and the 1984
recommendation sets maximum packet size to 4096. Generally, the size of packets that
are actually used on a network is fixed and understood by the DTEs. However, some
networks offer an option that allows the DTE and DCE to negotiate the size of packets
when the call is placed.

SX.25 Software Components

Figure 1-1 illustrates the X.25 protocol layers as implemented in the SX.25 application.
Notice from Figure 1-1 that the Internet Protocol (IP) is substituted for upper X.25 layers,
and that each application layer is supported by a different combination of layers below it.
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Figure 1-1 5X.25 Protocol Layers
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SX.25 Functional Layers

Level 1 of the X.25 protocol is the physical layer that governs the transmission of electrical
signals on the network. Level 1 comprises the hardware itself, which is referred to as the
link, and the device driver that interfaces to the hardware, which is referred to as the port.
Figure 1-1 represents the physical level as a LAN and WAN port on the SX.25 host.

Level 2, the data link level, manages access to the hardware channel and the sequencing
of data over the channel. The link level prepares information for transmission in units
known as a frames. In Figure 1-1, the link-level function is represented by LLC-2, which
performs link-level functions in LANs, and LAPB, which performs link-level functions
for WAN connections.

Level 3, the packet level, establishes the logical connection between the communicating
hosts and controls the flow of information between them. Level 3 transmits information
in packets, which contain addressing and control information in addition to data.
Figure 1-1 refers to level 3 as the packet level protocol, or PLP, layer.

The application level, (level 7 in the OSI model), supports user and administrative
services. Figure 1-1 indicates that SX.25 offers PAD (X.25 user services) and PADD (the
PAD daemon), TCP/IP, UUCP, and locally developed user applications at this level. The
interface between the application level and the lower level protocols is provided by the
IRIX operating system and IRIX networking services.

Subnet IDs and DTE Addresses

Each WAN and LAN port on a Silicon Graphics host operates as a DTE. Every port is
assigned its own DTE address, which uniquely identifies the port to the network. To SX.25
software, however, the port is considered a subnetwork. SX.25 uses a subnet ID to direct
incoming packets internally after the packets arrive. For this reason, every SX.25 port
must be assigned both a DTE address and a subnet ID when you configure it for network
operation.

The SX.25 Configuration File

The SX.25 configuration file defines the operation of all X.25 network connections on a
Silicon Graphics host. The default SX.25 configuration file is /etc/config/snetd.options. You
can specify an alternate filename for snetd.options, and you can create multiple
configuration files with unique filenames if you choose to.
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The SX.25 configuration file contains a record for each configured port on the system. The
record contains a subnetwork ID, a network address, and the names of the parameter
files to be used to configure the port’s protocol stack.

Protocol Parameter Files

The protocol stack for an X.25 port contains dozens of adjustable parameters that must
be set to coincide with the operating parameters of the network to which the port is
connected. To make port configuration more efficient, 5X.25 provides parameter files that
contain the parameter settings used by the vast majority of PDNs. These factory-shipped
files make it unnecessary to specify protocol parameters individually, in most cases.

Two files configure the protocol stack for a given port: a packet-level parameter file and
a link-level parameter file. When the host’s networking applications start, the snetd
daemon builds the protocol stack for a port using the parameter files that are specified in
the configuration file.

Notice from Figure 1-1 that the LAPB protocol defines link-level functions on WAN
ports, and LLC2 defines link-level functions on LAN ports. To accommodate all port
configuration possibilities, SX.25 provides three types of protocol parameter files: X.25
parameter files, a LAPB parameter file, and LLC2 parameter files.

X.25 Parameter Files

An X.25 parameter file specifies the packet-level functions for WAN and LAN ports.
These specifications include logical channel assignments, packet and window sizes,
timers, and other transmission specifications. Factory-shipped X.25 parameter files
implement 1980, 1984, and 1988 X.25 recommendations for DTEs and DCEs. Because the
packet-level parameter settings in these files are compatible with the requirements of
most PSNs, it is usually not necessary to specify packet-level parameters individually.

To configure a port with a factory-shipped file, you select the file from the X.25 Parameter
File list during the port configuration procedure (see Figure 4-7). You can check the
settings in any file on this list by opening it with gx25adm (see “The Open Button” in
Chapter 4).

If you determine that factory-shipped files are not suitable, you can create custom X.25
parameter files (this process is described in “Creating an X.25 Parameter File” in
Chapter 7). Any custom parameter file that you create is added to the X.25 Parameter File
list so that you can select it during subsequent port configuration procedures.
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LAPB Parameter Files

A LAPB parameter specifies link-level functions for WAN ports. These specifications
include timer settings, window and frame sizes, and other WAN transmission
parameters. Information in the LAPB parameter file is passed to LAPB, the IRIX LAP
multiplexor that manages port I/O. One factory-shipped LAPB file is included in the
SX.25 application. Because the parameter settings in this file comply with link-level
requirements of most PSNss, it is usually not necessary to specify link-level parameters
individually.

To configure a port with the factory-shipped file, you select the file from the LAPB
Parameter File list during the port configuration procedure (see Figure 4-7). You can
check the settings in this file by opening it with gx25adm (see “The Open Button” in
Chapter 4).

If you determine that the factory-shipped file is not suitable, you can create a custom
LAPB parameter file (this process is described in “Creating a LAPB Parameter File” in
Chapter 7). Any custom parameter file that you create is added to the LAPB Parameter
File list so that you can select it during subsequent port configuration procedures.

LLC2 Parameter Files

An LLC2 parameter file specifies link-level functions for LAN ports. These specifications
include timer settings, window sizes, P-bit acknowledgment, and other LAN
transmission parameters. Information in the LLC2 parameter file is passed to LLC2, the
IRIX LAP multiplexer that manages port I/O. Parameter settings for link-level functions
are defined by network media, so the SX.25 application provides a factory-shipped LLC2
parameter file for Ethernet, FDDI, and Token Ring LANSs. Because the settings in this file
comply with industry standards, it is usually not necessary to specify LLC2 parameters
individually.

To configure a port with a factory-shipped file, you select the file from the LLC2
Parameter File list during the port configuration procedure (see Figure 4-10). You can
check the settings this file by opening it with gx25adm (see “The Open Button” in
Chapter 4).

If you determine that the factory-shipped file is not suitable, you can create a custom
LLC2 parameter file (this process is described in “Creating an LLC2 Parameter File” in
Chapter 7). Any custom parameter file that you create is added to the LLC2 Parameter
File list so that you can select it during subsequent port configuration procedures.
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IP Network Connections

SX.25 supports connections to Internet Protocol (IP) networks, allowing users on the
SX.25 host to use TCP/IP network services. It also supports an IP host map, which allows
users to enter hostnames rather than addresses in their connection requests. The SX.25
implementation complies with RFC 877.

In IP/X.25 internetworks, X.25 networks function as subnetworks of the IP network. X.25
connections to IP networks are implemented by means of the IP to X.25 encapsulation
driver (IXE), which links IP networks with the X.25 stack (see Figure 1-1). IXE transmits
IP datagrams between X.25 nodes over an X.25 virtual circuit. The remote X.25 node may
be on the same network or on a different one.

Hosts linked to the IXE driver have two associated addresses: an Internet address and an
X.25 address. Address mapping is determined by the mode of operation that is in use,
CCITT or DDN.

Note: Sending IP broadcast packets over an X.25 network is impractical and is not
supported.

CCITT Addressing

SX.25 maintains an internal address table called the IXE map. The IXE map holds address
pairs that associate the IP address with the X.25 address of a node. The IXE database is
consulted when an outgoing IP packet requires a new connection and when incoming
X.25 connections contain IP packets. Requests to send IP packets to X.25 nodes for which
there is no IXE map record result in an error.

When an incoming connection arrives at the X.25 layer and is destined for the IXE driver,
the X.25 address must match an entry in the IXE map. If no matching entry is located, the
connection is refused. In general, if an incoming connection has been established, the
same connection is used for outgoing datagrams to the calling party.

For each name and address pair, you can specify the packet and window sizes to be
requested on connections and the number of concurrent virtual circuits that are allowed.
The default maximum number of entries in the IXE map is 100.
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DDN Addressing

When operating in DDN mode, IP to X.25 address mappings are not normally obtained
from the internal address table. This means that in normal operation, only the default
X.25 facilities are available. It is possible, however, to use different facilities, packet and
window sizes, and so on. To do this, you must enter the information into the internal
address table yourself. This means entering the correct X.25 address, derived from the
DDN address; refer to the Defense Data Network X.25 Host Interface Specification.

PAD and PADD Connections

The basic connection service on an SX.25 host allows its users to run PAD applications.
To simplify the connection process for users, you can create a PAD map. This map is a
database of X.25 hostnames, addresses, and connection parameters that automatically
supplies addresses and connection parameters in PAD connection requests; users supply
only the remote hostname in their pad commands. The PAD map can also contain host
aliases for situations in which a host is known by multiple names.

SX.25 hosts offer PAD services to network users by means of PADD, the PAD daemon
service. The PADD server listens for incoming requests from PAD users and creates a
login process that supports the virtual terminal connection. If you wish, you can restrict
the X.25 hosts to which the SX.25 host can supply PAD services by creating a list of listen
strings. The listen strings list contains the hosts addresses from which PADD accepts
connection requests.

About gx25adm Menus

10

When the gx25adm utility starts, the primary window is displayed (shown in Figure 3-1).
The menus offered on the primary window provide access to all SX.25 configuration
functions and the files that store configuration information.

Figure 1-2 illustrates how gx25adm menus are used to access configuration functions
and the files that support them.



About gx25adm Menus

Files for
maps and lists

Protocol
parameter
files

Figure 1-2 Overview of gx25adm Menus

Accessing Port Configuration Functions

WAN and LAN ports are configured using the WAN and LAN port configuration
windows (see Figure 4-7 and Figure 4-10). These windows provide access to the SX.25
configuration file, which contains a record for each configured port on the host (see “The
SX.25 Configuration File” for details). You open the configuration file using options on
the File menu (shown in Figure 3-2), then you select a port to configure. Selecting a port

11
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displays the WAN or LAN port configuration window and opens the configuration file
record for the port.

The WAN and LAN port configuration windows also provide access to the protocol
parameter files for a given port (see “Protocol Parameter Files”), but these files are not
normally opened during a configuration session. You open protocol parameter files only
if you plan to create customized versions of these files (see “Evaluating SX.25 Parameter
Files” in Chapter 2).

Accessing Optional Features

The Edit menu (shown Figure 3-3) provides access to the optional features that you can
add to an SX.25 host or to individual ports on the host. SX.25 host options include IP and
X.25 host maps, lists of the PADD services and subnetworks on the host, and IRIX kernel
parameters for the SX.25 application. This information is stored in database files that are
accessed when you choose an Edit menu option.

Individual port options include adding IP network connections and PVCs to the port.
When you configure an individual port option, the configuration information is recorded
in the SX.25 configuration file. For this reason, you must open the configuration file from
the File menu before you use these Edit menu features.

Accessing Support Functions

The gx25adm utility provides two support functions: a network function that stops and
starts IRIX network services on the host, and a kernel function that rebuilds the IRIX
operating system kernel. Support functions are accessed from the Action menu (shown
in Figure 3-4).



Chapter 2

Planning for SX.25

Planning an SX.25 host configuration involves identifying the communications ports on
the system and deciding on the services that each port will provide (see Chapter 1 for an
explanation of available SX.25 services). It is also necessary to collect information that

must be provided during the configuration process. This chapter contains these sections
to help you with configuration planning:

¢ “Port Naming Conventions”
¢ “Evaluating SX.25 Parameter Files”

* “Collecting Information for Port Configurations”

Port Naming Conventions

When the SX.25 application starts, it requests a hardware inventory (see the hinv(1M)
reference page) of the number of communications ports that are installed on the system.
S5X.25 automatically assigns a name to each port that the inventory reports.

The maximum number of serial ports on a Silicon Graphics system varies with the bus
architecture used on different system models. Table 2-1 lists the bus type and model of

13
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each Silicon Graphics system, the maximum number of communication ports that each
model can contain, and the name that SX.25 software assigns to each port:

Table 2-1 Port Numbering on Silicon Graphics Systems
Bus Type Model Maximum Ports  Distribution of Ports  Port Name
GIO Indy 4 Slot 1, 2 ports wan00
wan01
Slot 2, 2 ports wanl0
wanll
Indigo 4 Same as Indy Same as Indy
CHALLENGES 4 Same as Indy Same as Indy
EISA Indigo 2 8 Slot 1, 2 ports wan00
wan01
Slot 2, 2 ports wanl0
wanll
Slot 3, 2 ports wan20
wan21
Slot 4, 2 ports wan30
wan31
CHALLENGEM 8 Same as Indigo2 Same as Indigo2

14
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Table 2-1 (continued) Port Numbering on Silicon Graphics Systems

Bus Type Model Maximum Ports  Distribution of Ports  Port Name

VME CHALLENGE L 16 Slot 1, 4ports wan00
wan(1
wan(02
wan03

Slot 2, 4ports wanl0
wanll
wanl2
wanl3

Slot 3, 4 ports wan20
wan21
wan22
wan23

Slot 4, 4 ports wan30
wan31
wan32

wan33

CHALLENGE XL 16 Same as Same as
CHALLENGE L CHALLENGE L

Evaluating SX.25 Parameter Files

SX.25 software includes a collection of files that set parameters for link-level and
packet-level protocols to values used by the vast majority of PDNs. In most cases, these
values are appropriate for your port connections, and you can establish X.25 WAN and
LAN connections using SX.25 parameter files. However, if you are using SX.25 for the
first time, it is important to evaluate the suitability of the as-shipped files for connecting
to your particular network and to identify any adjustments that might be needed. You
can check factory-shipped parameter settings by opening the files with gx25adm (see
“The Open Button” in Chapter 4).

If you are unsure of the operating requirements for a network to which you are
connecting, discuss your questions with your network service provider.

15
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Collecting Information for Port Configurations
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If you plan to use SX.25 protocol parameter files, be prepared to supply this information
during the configuration procedure:

A subnet ID for the port. This ID identifies the protocol stack to the SX.25 daemon.

A DTE address for the port. Ask your network service provider to supply
addresses. See “X.121 Addresses” in Appendix A if you need detailed information.

The names of the ports to be configured. See Table 2-1 for the list of SX.25 port
names.

Whether ports will operate as a DTE or DCE and the X.25 recommendation to
which the port must conform (1980, 1984, or 1988).

The link procedure to be used on each port: LAP, LAPB, or LAPB with extended
addressing for WAN ports; LLC1 or LLC2 for LAN ports.

Additional Information for Custom Protocol Files

If you plan to create custom parameter files, be prepared to substitute settings in the X.25
parameter files for settings that are required by your network service.

You might need to reset one or several of the packet-level parameters listed below to
operate on the network to which you subscribe:

The extended address for any ports on which you plan to use OSI NSAP or other
extended addressing.

The modulo number (8 or 128) used for packet sequencing

The type of logical channels that you will use and their numbers. (See “Logical
Channels” in Chapter 1 and Figure 7-3.) Include PVCs if you plan to use them.

The default maximum size of packets and windows on local and remote DTEs, and
the maximum size of the network service data unit (NSDU). (See Figure 7-4.)

Settings for packet-level timers, counters, and delays. (See Figure 7-5, Figure 7-6,
and Figure 7-7.)

Throughput class boundaries. (See Figure 7-8.)

The types of negotiation that are supported: packet size, window size, and
throughput class



Collecting Information for Port Configurations

If you belong to a closed user group (CUG), the conventions that are followed. (See
Figure 7-9.)

The optional facilities to which you subscribe. (See Figure 7-10.)

Conventions for handling international calls, priority requests, addresses in
outgoing calls, and diagnostic packets. (See Figure 7-11.)

Conventions for handling D-bits. (See Figure 7-12.)

You might need to reset one or several of the link-level parameters listed below to operate
on the network to which you subscribe:

Frame and window specifications. (See Figure 7-14 and Figure 7-17.)
Link-level timers. (See Figure 7-15 and Figure 7-18.)
Link-level error handling and state indicators. (See Figure 7-16.)

XID parameters for LANSs. (See Figure 7-19.)

Additional Information for IP Connections

If you plan to configure IP on any connections (see “IP Network Connections” in
Chapter 1), plan to supply this information during the configuration procedure (also see
Figure 5-1):

For each network to which the SX.25 host is connecting, a local Internet address for
the SX.25 host, the subnetwork mask of the network, the version of X.25 run on the
network, and the addressing scheme that the network uses (CCITT or DDN)

Whether to allow broadcast packets

The high-water mark for data concatenation (if higher than 576 octets)
Maximum idle and minimum connection time for virtual circuits
Mode of operation, CCITT or DDN

How to handle reset and expedited data requests

PVC channel ranges, if you plan to use PVCs

Listen information for applications using the connection

17
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If you plan to create an IP /IXE map, which allows users to designate hosts by their name
rather than by their address, you need to supply this information:

¢ The address or name of the IP hosts to which the SX.25 host will connect. If you plan
to use a hostname, it must be listed in SX.25 hosts file (/etc/hosts).

¢ The maximum packet and window size to be used in connections

Additional Information for PAD and PADD Connections

If you plan to use the PAD map (see “PAD and PADD Connections” in Chapter 1), plan
to supply this information:

® The name of the X.25 hosts to which local users will connect and any aliases by
which these hosts are known (see Figure 5-6 and Figure 5-9)

¢ The address of the X.25 hosts to which users will connect for PAD sessions. For
WAN connections, the address is an X.121 address; for LAN connections, it is an
LSAP address. Address information must include an extension for any host that is
using extended addressing.

e The X.29 version used on the remote host and any call user data (CUD) that is
required in a connection request

e The incoming and outgoing packet and window sizes on the remote host, whether
it uses fast select, and whether it accepts reverse call charges (see Figure 5-7)

e The closed user group (CUG) number and whether the CUG is bilateral or
multilateral. If calls are routed by means of a recognized private operating agency
(RPOA), the RPOA numbers (Figure 5-8).

If you plan to offer PADD services (see “PAD and PADD Connections” in Chapter 1),
plan to supply this information:

e Any CDU that is required in incoming calls

e The addresses of hosts from which calls will be accepted

e  Whether CDU and address data must match exactly or in part

e  Whether the addresses are X.25 DTE (WAN connections) or X.25 NSAP (LAN
connections)



Chapter 3

Getting Started With gx25adm

The gx25adm utility is a graphical interface for configuring the SX.25 application on
Silicon Graphics workstations and servers. Using gx25adm menus and dialogs, you can
configure connections to X.25 WANSs, X.25 LANSs, or connections to IP networks. You can
also configure PAD and other user applications that rely on the underlying X.25 network
connection. Because configuration parameters are preset to conform to the requirements
of most X.25 network service providers, the configuration process is quick and efficient.
This chapter contains these sections to help you get started using gx25adm:

e “Starting the gx25adm Utility”

¢ “Using the Primary Window”

® “Using the File Menu”

¢ “Using the Edit Menu”

* “Using the Action Menu”

* “Using gx25adm Help”

* “Configuration Procedure at a Glance”

Starting the gx25adm Utility

The gx25adm utility allows a privileged user or root to configure the protocol stack for
an X.25 port on a host; gx25adm also allows you to configure features on the host that
support network services. The utility is accessible from the Indigo Magic " Desktop. You
can start gx25adm by any of the these methods:
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From the Find Toolchest

Use this procedure to start gx25adm from the Find toolchest:
1. Choose “An Icon” from the Find toolchest.

2. Type gx25admin the “Find an Icon” dialog.

3. Drag the icon onto your desktop.

4. Double-click on the gx25adm icon to launch the utility.

From the Icon Catalog

Use this procedure to start gx25adm from the Icon Catalog:
1. Choose “Desktop Tools” from the Find toolchest.
2. Double-click the gx25adm icon to launch the utility.

From a Shell

If you are configuring a remote workstation or server from a local system that runs from
an ASCII console, start gx25adm from a shell. In this case, the local system must be
running xeoe client software (see the SX.25 Release Notes for information on software
prerequisites).
Use this procedure to start gx25adm from a shell:
1. Type su to become the root user.
2. Type gx25admcommand from an IRIX shell:

# gx25adm

Using the Primary Window

20

The gx25adm primary window is displayed when you start the gx25adm utility (see
Figure 3-1). Use the primary window to access the list of ports that are present on the
SX.25 host, and to access the menus and other windows that allow you to configure the
host and its ports for operation on an X.25 network.



Using the Primary Window

When you first start gx25adm, the “Ports:” list is empty. To display entries in the ports
list, open an SX.25 configuration file (see “Using the File Menu” for information on
opening files). Then, use the ports list to select a port to be configured, reconfigured, or
removed from the configured ports list.

Figure 3-1 Primary Window for gx25adm

Primary Window Tabs

When you select the Configured tab (shown in Figure 3-1), the primary window shows
a list of ports that are already configured for network operation. When you select the
Unconfigured tab (shown in Figure 4-2), the primary window shows a list of ports that
are available but not yet configured. (Remember that the configuration file must be open
to display a ports list.) Notice from Figure 3-1 and Figure 4-2 that the buttons on the
primary window change, depending on the tab that is selected.
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Using the File Menu
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Primary Window Buttons

When the Unconfigured tab is active, select a port on the ports list and click the Configure
button to display an empty port configuration record. Complete this record to configure
the port (see “WAN Port Configuration Procedure” and “LAN Port Configuration
Procedure” in Chapter 4 for instructions).

When the Configured tab is active, select a port on the ports list and click the Display
button to display the current port configuration record. Make the necessary changes to
this record to reconfigure the port. If you want to remove a port from the ports list, click
the Delete button. If you save the configuration file after removing the port from the list,
you remove the port from service and the port is returned to the Unconfigured ports list
(see “Using the File Menu” for instructions on saving the configuration file).

Use the File menu, shown in Figure 3-2, to open and save configuration files, the files that
define how individual X.25 ports on the system operate. For any given port on the
system, this file must contain a subnetwork and network address and the name of the
parameter files that define the protocol stack for the port. Also use the File menu to create
customized versions of the protocol parameter files (if you determine that the original
SX.25 parameter files are unsuitable for your needs) and to save updates to the maps and
other records that support SX.25 options.

Note: Information that you add to a configuration file or protocol parameter file during
an gx25adm session is not permanently recorded until you explicitly save the file using
the “Save” or “Save As” option on the File menu.

e

New Cirl+
Open... Cirlv O
Save CirlS
Save As...

Exit Cirf+Q

Figure 3-2 File Menu



Using the File Menu

The New Option

Use the “New” option at the beginning of a port configuration session to create a
configuration file that does not currently exist. The new file will contain the information
that you enter in gx25adm windows during the session. This information will be
recorded in the new file when you save it with the “Save” or “Save As” option.

The Open Option

Use the “Open” option at the beginning of a port configuration session to open an
existing configuration file to review its contents or change them. When you select this
option, gx25adm prompts you to enter the name of the file that you plan to modify. Enter
the full pathname of the file. It is important to remember that no changes are made to this
file until you save it using the “Save” or “Save As” option.

The Save Option

Use the “Save” option to store information in a configuration file that you opened earlier
in the session. If you are saving a new configuration file, gx25adm prompts you to enter
a filename. Enter the full pathname of the file. You can save the new file in any directory;
however, by convention, IRIX configuration files are stored in the /etc/config directory. If
you are saving changes to an existing file, gx25adm saves a new copy of the file that you
specified when you opened the file.

The Save As Option

Use the “Save As” option to store a configuration file under a new filename. When you
select this option, gx25adm prompts you to enter the new filename. Enter the full
pathname of the file. You can save the file in any directory; however, by convention, IRIX
configuration files are stored in the /etc/config directory.

The Exit Option

Use the “Exit” option to end a gx25adm session. If you made any configuration changes

that you want to save, be sure to use the “Save” or ’Save As” options on the File menu
before selecting the “Exit” option. If you have any unsaved changes remaining from the
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Using the Edit Menu
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session when you select the “Exit” option, gx25adm warns you that your changes will be
lost unless you take action with “Save” or “Save As.”

Use the Edit menu, shown in Figure 3-3, to set the IRIX kernel parameters for an SX.25
host and to configure the optional features that SX.25 offers. SX.25 optional features rely
on maps and other information about network hosts and services that you supply during
gx25adm sessions. This information is stored in the configuration file (snetd.options, by
default) and other supporting files.

Whenever you create or modify a configuration file, you must save your changes using
File menu options. Whenever you create or modify supporting files, you use the Close
button to save your changes (shown in Figure 5-2). To put the new file into effect, you
must also stop and restart the network using Action menu options. Whenever you use
the Edit menu to set kernel parameters, you must reboot the SX.25 host.

Edit |

Pad MapiXhosts... CirfrP

IXE Map... Cirf+!
PADD... Ctri+D
Subnetworks... Cirf+rS

Kernef Parameters... ClivK

Figure 3-3 Edit Menu

The PAD Map/Xhosts Option

Use the “PAD Map/Xhosts” option to create a list of the names of remote PADD hosts
and the connection information that the hosts require. This map reduces the amount of
information that users must supply when they begin a PAD session. After the list is
created, use this option to modify X.25 host information or remove hosts from the list. See
“The PAD Map Option” in Chapter 5 for instructions on creating the PADD map.



Using the Edit Menu

The IXE Map Option

Use the “IXE Map” option to create the list of Internet (IP) hosts with which this system
will communicate. You are required to supply the name and address of each IP host; you
can also specify a host alias if you choose to use one. After the list is created, use this
option to modify Internet host information or remove hosts from the list. See “The IXE
Map Option” in Chapter 5 for instructions on creating the IXE map.

The PADD Option

Use the “PADD” option to compose a list of listen strings that identify the calls for which
the SX.25 host will provide PAD services. Incoming calls for service are handled by the
PAD daemon, PADD. See “The PADD Listen Strings Option” in Chapter 5 for
instructions on creating and changing this list.

The Subnetworks Option

Use the “Subnetworks Option” to create a list of the subnetwork names on this host. The
subnetwork list allows users to designate subnetworks by a name instead of by an
address. See “The Subnetwork Names Option” in Chapter 5 for instructions on
configuring subnetwork names.

The Kernel Parameters Option

Use the “Kernel Parameters” option to set system-wide limits on the number of virtual
circuits and UUCP connections that an SX.25 host will support. Because these parameters
affect the IRIX kernel, you must reboot the SX.25 host whenever you use this option. See
“Procedure to Configure Global Kernel Parameters” in Chapter 4 for instructions on
configuring global kernel parameters.
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Using the Action Menu
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Use the Action menu, shown in Figure 3-4, to start and stop networking and to create a
new IRIX kernel.

Caution: When you use this menu to stop networking, all network activity is suspended
until you restart the host; when you use this menu to rebuild the IRIX kernel, the X.25
host must be rebooted.

Action I

Metwork [
Creale Kernef CirlrC

Figure 3-4 Action Menu

The Network Option

Use the “Network” option to start and stop X.25 operations on the system. When you
select “Start” from this option, gx25adm prompts you to specify the configuration file to
be used for operation. Enter the full pathname of the configuration file or use the Filter
button on the file specification prompt to enter wildcards in your specification. If the
configuration file that you specify contains any changes, the changes become effective at
network startup. An information message is posted when the network starts.

When you select “Stop” from this option, an information message is posted when the
network stops. Stopping the network suspends connections to all networks in which the
host is a member.

The Create Kernel Option

Use the “Create Kernel” option to build a new IRIX kernel after you set new IRIX kernel
parameters with the “Kernel Parameters” option on the Edit menu (see “The Kernel
Parameters Option” in Chapter 3 for details) or the Setup menu on the WAN port
configuration window (see “The Setup Menu” in Chapter 4 for details). Selecting the
“Create Kernel” option configures and stores the new IRIX kernel; however, the new
kernel is not installed until the next system reboot. See “Procedure to Rebuild the IRIX
Kernel” in Chapter 4 for instructions on configuring and rebuilding an IRIX kernel.



Using gx25adm Help

Using gx25adm Help

Use the Help menu on the primary window (see Figure 3-1) to display a list of the help
topics that are available from this window. Select the “Overview” option to display
general information about the primary window and port configuration windows and the
features that these windows offer.

In addition to the Help menu, you can also get help on individual window features by
using the F1 key. For example, to request help on the File menu, move the cursor to the
label on the menu bar and press F1.

Configuration Procedure at a Glance

Figure 3-5 illustrates a typical gx25adm session in which an SX.25 host is configured for
basic X.25 network connection services. In this session, the host’s global parameters are
configured first, then individual ports on the host are configured. When all ports are
configured, configuration information is saved in the configuration file and the IRIX
kernel is rebuilt.
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Figure 3-5 The Port Configuration Process
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Configuration Procedure at a Glance

The order of the configuration process can vary from the order that is illustrated in
Figure 3-5. However, because all changes to global parameters and some changes to
individual port parameters affect the IRIX kernel, you must rebuild the IRIX kernel (the
final step in Figure 3-5) after configuring kernel parameters.

Notice from Figure 3-5 that individual port configurations might be interrupted by an
additional step: creating custom parameter files. If SX.25 factory-shipped parameter files
are not suitable for connection to a particular network, you must create custom
parameter files as part of the configuration process (see “Protocol Parameter Files” in
Chapter 1 for information on factory-shipped files). Any custom file that you create can
be used to configure other ports that require the same parameters. (Detailed
configuration instructions are given in Chapter 4.)

Figure 3-5 does not include procedures for configuring the optional X.25 features that
SX.25 offers. In general, however, optional features are added to a port after it is
configured for the basic connection service. Options that affect the SX.25 host (such as
PADD services) can be added at any time. (See Chapter 5 for a list and description of
SX.25 optional features and instructions on configuring them.)
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Chapter 4

Configuring a Host for Basic Connections

Configuring an SX.25 host for basic X.25 WAN or LAN connections involves setting
global parameters for the SX.25 host, setting parameters on individual ports, and
rebuilding the IRIX kernel. All global configuration parameters and some individual
port parameters affect the contents of the IRIX kernel. So whenever you change IRIX
kernel parameters, the kernel must be rebuilt to put your changes into effect.

This chapter contains the sections listed below to help you configure an SX.25 host for
basic X.25 network connections. It might be useful to refer to Figure 3-5 for an illustration
of the configuration process as you do these procedures:

e “The Global Kernel Parameters Option”

* “Procedure to Configure Global Kernel Parameters”

e “About the Ports List”

e “Port Selection Procedure”

¢ “Using Port Configuration Windows”

* “WAN Port Configuration Procedure”

* “LAN Port Configuration Procedure”

e “Procedure to Rebuild the IRIX Kernel”

Note: Because rebuilding the kernel requires rebooting the host, you might want to delay

the kernel rebuild until after you configure the global parameters and the basic
connection service for all WAN ports.
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The Global Kernel Parameters Option

Kernel parameters specify how to create the streams and memory blocks that support
X.25 network connections. Use the “Kernel Parameters” option on the Edit menu to

specify global kernel parameters for an SX.25 host. These parameters specify the number
of virtual circuits and UUCP connections that the host can sustain simultaneously. They
also specify the X.29 protocol, which is the interface between PAD users on the host and
the X.25 network.

Do not confuse the global Kernel Parameters option (on the Edit menu) with the “Kernel
Parameters” option on the Setup menu of the WAN port configuration screen. Whereas
global kernel parameters pertain to the entire host, port kernel parameters pertain only
to the individual WAN port for which they are set (see “Setting WAN Port Kernel
Parameters” for details). Whenever you use either Kernel Parameters option, you must
reboot the SX.25 host to put your changes into effect.

Procedure to Configure Global Kernel Parameters
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Use this procedure to configure global kernel parameters.

1.

2.

3.

Start gx25adm to display the primary window.

The primary gx25adm menu is displayed when you start the utility (shown in
Figure 4-2). See “Starting the gx25adm Ultility” in Chapter 3 if you need startup
instructions.

Open snetd.options to store the global kernel parameters.

Use the “Open” option from the File menu to open the SX.25 configuration file,
which is normally /efc/config/snetd.options (see “The SX.25 Configuration File” for
information on this file). If you prefer to create a new configuration file by a
different name, use the “New” option from the File menu instead (see “The Open
Option” or “The New Option” for information on using these options).

Select “Kernel Parameters” from the Edit menu.

After your selection, the Kernel Configuration screen, shown in Figure 4-1, is
displayed.



Procedure to Configure Global Kernel Parameters
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Figure 4-1 The Kernel Configuration Screen

4.

Specify the maximum number of virtual circuits for this system.

Use the slider to specify the maximum number of virtual circuits that this system
can support simultaneously. The valid range is 0 through 32,768.

Enter the maximum number of UUCP connections for this system.

Use the slider to specify the maximum number of UUCP connections that this
system can support simultaneously. The valid range is 0 through 2048.

Enter the X.29 protocol recommendation to be used on this system.

The default X.29 protocol recommendation is 88, for 1988. Click the option menu to
make a different selection (84 for 1984 or 80 for 1980).

Click the OK button to confirm your kernel parameter settings.

Clicking OK signals gx25adm that the kernel parameter settings you entered are
correct; it does not record the settings permanently. Settings are not recorded until
you explicitly save them in a configuration file (step 8, which follows).

Save your selections in the SX.25 configuration file.

Use the “Save” option from the File menu to save your configuration selections in
the /etc/config/snetd.options file. If you used the “New” option to create a new
configuration file in step 2, use the “Save As” option to save your selections instead.
(See “Using the File Menu” in Chapter 3 if you need instructions for saving files.)
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About the Ports List

Because the information that you specified affects the IRIX kernel, you must complete the
procedures in “Procedure to Rebuild the IRIX Kernel” to put your changes into effect.
However, you should plan to complete individual port configuration procedures before
rebuilding the kernel, since some WAN port parameters affect kernel contents.

Before you perform any configuration procedure on a port, you must first select the port
from the ports list. This list comprises all ports on the system that SX.25 software
determines to be available for configuration: previously configured ports are listed when
the Configured tab is selected, and unconfigured ports are listed when the Unconfigured
tab is selected. Selecting a port opens the record for the port in the SX.25 configuration
file (see “The SX.25 Configuration File” in Chapter 1 for a description of this file). After
the port is selected, go on to the instructions in a specific configuration procedure to
complete the configuration process.

Two loopback ports, wloop0 and wloop1, are automatically included in the list of ports
available for configuration. If you plan to do local testing of the X.25 protocol stack, or if
you plan to test an X.25 network application, configure the loopback ports first using the
WAN and LAN port configuration procedures in this chapter. Your loopback
configuration must include a DTE and a DCE component.

Port Selection Procedure
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Use this procedure to select a port from the ports list:
1. Start the gx25adm utility, if you have not already done so.

See “Starting the gx25adm Utility” in Chapter 3 if you need startup instructions.
2. Open the configuration file, if you have not already done so.

Use the “Open” option from the File menu to open an SX.25 configuration file. The
default configuration file is /etc/config/snetd.options (see “The SX.25 Configuration
File” for information on this file). If you prefer to create a new configuration file by a
different name, use the “New” option from the File menu instead (see “The Open
Option” or “The New Option” for information on using these options).
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3. Select the Configured or Unconfigured tab from the primary window.

If you are configuring a port that is not yet set up for X.25 operation, select the
“Unconfigured” tab. A list of unconfigured ports appears in the Ports window after
your selection.

If you are changing the operating parameters of a port that is already configured,
select the Configured tab. A list of configured ports appears in the ports window
after your selection.

Figure 4-2 illustrates the primary window with a list of unconfigured ports.

Figure 4-2 Sample Ports List

4. Select the port that you want to configure.

For an unconfigured port, select a port from the Ports list on the Unconfigured tab
and click the Configure button. For a previously configured port, select a port from
the Ports list on the Configured tab and click the Display button. Figure 4-2 shows
that LAN port ec0 is selected from the unconfigured ports list.
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Go to the “WAN Port Configuration Procedure,” the “LAN Port Configuration
Procedure,” or a procedure in Chapter 5 to complete the configuration process on the
port that you selected.

Using Port Configuration Windows
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Use the WAN or LAN port configuration window, shown in Figure 4-7 and Figure 4-10,
to configure a port for connection to an X.25 network. The information that you enter in
this window creates a configuration record for the port in the snetd.options file (or an
alternative configuration file, if you choose to use one). The new record is written to
snetd.options when you save the file using an option from the File menu (see “Using the
File Menu” in Chapter 3 for details). The port configuration record governs how the port
will function when snetd.options is put into effect (see “The Network Option” in
Chapter 3 for information on putting configuration files into effect).

To configure a port, specify its subnet ID and its DTE address; then, select a
factory-shipped parameter file from each scroll list to specify link-level and packet-level
parameter settings. Port configuration windows contain two scroll lists: an X.25 files and
LAPB files list appears in the WAN window, and an X.25 files and LLC2 files list appears
in the LAN window (See “SX.25 Software Components” in Chapter 1 for information on
factory shipped files and “Evaluating SX.25 Parameter Files” in Chapter 2 to determine
the suitability of factory-shipped files for your network connections.)

The Setup Menu

The Setup menu appears only on the WAN port configuration window. Use this menu to
set kernel parameters for a WAN port when you configure it. Whenever you set port
kernel parameters, you must reboot the SX.25 host to put your settings into effect. (See
“Setting WAN Port Kernel Parameters” for more information.)

The Options Menu

The Options menu offers two port configuration options: use the IP/IXE option on this
menu to configure ports for connections to IP networks; use the PVC Map option to
specify the logical channels that will be dedicated to permanent virtual circuits. (See “The
IP/IXE Option” and “The PVC Map Option” in Chapter 5 for more information.)
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The Run Time Stacks Menu

The Run-Time Stacks menu offers options to configure an alternative X.25 and LABP
protocol stack. Use these options on an operating port to check its performance with
modified protocol parameter settings. The alternative stack can be used temporarily to
evaluate port performance; it can also be saved as the permanent protocol stack for the
port. (See “Run Time Parameters Option” in Chapter 5 for more information.)

The Help Menu

Use the Help menu on the WAN or LAN port configuration window to display a list of
the help topics that are available from this window. Select the “Overview” option to
display general information about the port configuration windows and the features that
they offer.

In addition to the Help menu, you can also get help on individual window features by
using the F1 key. For example, to request help on the SubnetID field, move the cursor to
the entry field and press F1.

Port Configuration Window Buttons

Both port configuration windows contain buttons for selecting a link procedure, buttons
for controlling entries in the scroll lists, and buttons for closing the port configuration
window. These buttons are described in the subsections that follow.

The Open Button

Use the Open button to open a parameter file in the scroll list and review the file’s
contents. If you open a factory-shipped file and find that you need to change it, you must
create a custom file to save your changes—the settings in a factory-shipped file are
permanent (see “The Save As Option” in Chapter 3 for instructions). If you open a
custom file and you want to change it, you can save your changes directly to the opened
file (see “The Save Option” in Chapter 3 for instructions).
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The Delete Button

Use the Delete button to remove a parameter file from the scroll list. You cannot use Delete
to remove a factory-shipped parameter file from a scroll list—the original version of each
factory-shipped file must always be available for port configurations.

The Assign Button

Use the Assign button after you select a parameter file from a scroll list to specify the file
in the configuration record for this port. When you click Assign, the selected filename is
displayed in the filename field above the scroll list. When you save the configuration file,
the parameter file that you selected is permanently recorded in the port’s configuration
record (see “The Save Option” in Chapter 3 for instructions).

Link Procedure Buttons

Use these buttons to specify the link procedure for a port. Click LAP or LAPB to select the
link procedure for a WAN port. If a WAN port uses extended addressing, click both the
LAPB and Extended LAPB buttons. Click LLCI or LLC2 to select the link procedure for a
LAN port. If a local or loop SAP is required for the LAN port, specify the SAP as a
hexadecimal number in the Local SAP or Loop SAP entry field.

The OK Button

Use the OK button to close the port configuration window and confirm that your entries
are correct. These entries are recorded in the port’s configuration record when you save
the configuration file using an option from the File menu (see “The Save Option” in
Chapter 3 for instructions).

The Cancel Button

Use the Cancel button to close the port configuration window and discard your entries.
When you click Cancel, no changes are made to the configuration file; any information
that was saved in the port configuration record from previous sessions remains
unchanged.
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WAN Port Configuration Procedure

The WAN port configuration procedure is described in two parts: the first part, “Setting
WAN Port Kernel Parameters,” explains how to set kernel parameters on a WAN port;
the second part, “Creating a WAN Port Configuration Record,” explains how to enter
information in a port configuration record and save it in the configuration file. Perform
both procedures to configure a new port, or perform either procedure separately to
change an existing configuration.

Setting WAN Port Kernel Parameters

Use this procedure to configure a port for connection to an X.25 WAN:
1. Complete the “Port Selection Procedure” if you have not already done so.

When you select a WAN port using the port selection procedure, the WAN port
configuration window is displayed (see Figure 4-7).

2. Use the Setup menu to specify the kernel parameters for this port.

Select the “Kernel Parameters” option from the Setup menu, shown in Figure 4-3, to
specify the parameters for this port that affect the IRIX kernel.

=.§ gn2dadm:WAN SyneCoemm Board T Port 0

Setup | Options  Bun Time Stacks Help

Kernef Parameters... ClivK| ||

A
Subnet 1D: g; DTE Address:

#.25 Parameter File: ! I|

Figure 4-3 Kernel Parameters Option on the Setup Menu
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3. Specify port kernel parameters listed on the Kernel Configuration window.

Port kernel parameters vary with the bus architecture of the SX.25 host. Use the
information in “Kernel Parameter Settings For GIO Systems,” “Kernel Parameter
Settings For ISC Systems,” and “Kernel Parameter Settings For VSC Systems” to
specify parameter settings for ports on a particular system mode.

4. Click the Apply and Close buttons when you finish specifying kernel parameters.
The port kernel parameters dialog closes after you apply your changes.

Continue the configuration process, using the instructions in “Creating a WAN Port

Configuration Record,” which follows. If this port was previously configured and the

configuration record is still correct, it is not necessary to create a new configuration

record. Go on to additional port configurations or, when all WAN port kernel parameters
are configured, go on to “Procedure to Rebuild the IRIX Kernel.”

Kernel Parameter Settings For GIO Systems

Use the parameter descriptions that follow Figure 4-4 to specify kernel level parameters
for GIO bus systems.

= g25acm:WAN Kernef wanio
Wan GIO Kernel Configuration:

4104
| | |
taximum Frame Size
Encoding: MRS = |

Apply Close Help
Figure 4-4 Kernel Parameters for Ports on a GIO Bus
Maximum Frame Size
Valid range is 0 to 4104 bytes.
Encoding Set to “NRZI” for SNA; set to “NRZ” for all other protocols.
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Kernel Parameter Settings For ISC Systems

Use the parameter descriptions that follow Figure 4-5 to specify kernel level parameters
for ISC bus systems.

Figure 4-5 Kernel Parameters for Ports on an ISC Bus
Maximum Frame Size
Valid frame size is 0 to 4096 bytes.

Electrical Interface
Select the electrical interface standard: CCITT V.35, CCITT X.21, or EIA
232.

Encoding Set to “NRZI” for SNA; set to “NRZ” for all other protocols.
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Kernel Parameter Settings For VSC Systems

Use the parameter descriptions that follow Figure 4-6 to specify kernel level parameters
for VSC bus systems.

Figure 4-6 Kernel Parameters for Ports on a VME Bus

Maximum Frame Size
Valid range is 0 to 4104 bytes.

Physical Interface
Set to “DTE” or “DCE.”

Baud Rate If this host will function as a DCE, set a baud rate. The valid range is 0
to 1544000.

No Automatic RTS
Set to “Disabled” to allow automatic request to send packets to be
transmitted; set to “Enabled” to prevent automatic request to send
packets from being transmitted.
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Encoding Set to “NRZI” for SNA; set to “NRZ” for all other protocols.

Creating a WAN Port Configuration Record

The procedure in this section explains how to configure a port for connection to an X.25
WAN using factory-shipped SX.25 parameter files to specify packet-level and link-level
protocol parameters. However, if you determine that a port requires customized
parameter files (see “Evaluating SX.25 Parameter Files” in Chapter 2 for details), you will
be instructed to perform additional procedures at step 4 and step 7 to create the necessary
files.

Note: If you decide to quit the port configuration procedure before completing it, click
the Cancel button to close the port configuration window and discard your entries.

1. Complete the “Port Selection Procedure” or “Setting WAN Port Kernel Parameters”
if you have not already done so.

If you have not already done so, perform these preliminary procedures to open the
port’s record in the configuration file and specify its kernel parameters to the IRIX
operating system. After you complete either of these procedures, the WAN port
configuration window is displayed (shown in Figure 4-7).
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Figure 4-7 The WAN Port Configuration Window

2.

Assign a subnet ID to the WAN port.

Select a letter from the Subnet ID field to assign the subnet ID. Use the up and down
arrows to scroll through the list. Your selection may be any letter from A through Z,
but it must be unique to this port; subnet addresses that are already assigned do not

appear in the scroll list (see “Subnet IDs and DTE Addresses” in Chapter 1 for more
information).
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3. Assign a DTE address to the port.

Enter a DTE address in the DTE Address field to assign an address to this port. (See
“Subnet IDs and DTE Addresses” in Chapter 1 for background information and
“X.121 Addresses” in Appendix A for address formatting information.)

4. Selecting an X.25 parameter file and check its settings.

Select a file from the X.25 Parameter Files list, based on the port’s function as DTE or
DCE equipment and on the X.25 recommendation implemented on the network (see
“X.25 Parameter Files” in Chapter 1 for background information). To check the
settings in the selected file, click the Open button (or double-click on the file) to
display its contents. Select the labeled tabs at the bottom of the window to view
additional parameter settings. To view an unlabeled tab, move the pointer to the
unlabeled area and use the right mouse button to select a tab from a pull down list
(see Figure 4-8).

General

Logical Channefs
PacketWindow Sizes
Timers

\ General /< Logical Channels /< PacketWindow Sizes /< Timers ‘ Counters
Fransit Delay

| oK I | Save As.. I | Cancel I | || Throughput Class
Closed User Groups

Subscription Options
Localization

D-Bit Controf

FThroughput Window/Packet

Figure 4-8 Tabs of X.25 Parameters

Note: Original X.25 parameter files cannot be modified. If you determine that
settings in the factory-shipped file are not suitable for the network to which this port
connects, go to “Creating an X.25 Parameter File” in Chapter 7 and complete that
procedure to create a customized file. Return to step 5 of this procedure when you
finish creating the custom file.
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5. Assign the selected X.25 file as a port configuration specification.

Click the Assign button to assign a selected X.25 parameter file as a configuration
specification for this port. Port configuration specifications are stored in the SX.25
configuration file when you save it using the File menu. If you want to remove a file
that you assigned, click the Delete button.

Select a link procedure for the port.

The link procedure is determined by the link access protocol implemented on the
network to which the port will connect. Most X.25 networks use LAPB rather than
LAP, since it allows either end to initiate transmissions. Click the check box beside
LAP or LAPB to select the link procedure for this port. If the network uses LAPB
with extended addressing, select both LAPB and Extended LAPB Addressing.

Select the LAPB parameter file and check its settings.

Select the LAPB parameter file for this port (see “LAPB Parameter Files” in
Chapter 1 for background information). To check the settings in the selected file,
click the Open button (or double-click on the file) to display its contents. Select the
labeled tabs at the bottom of the window to view additional parameter settings. To
view an unlabeled tab, move the pointer to the unlabeled area and use the right
mouse button to select a tab from a pulldown list (see Figure 4-9).

General /< Timer /< Link Level /

| QK I| Save As.. || Cancel || Help

Figure 4-9 Tabs of LAPB Parameters

Note: The factory-shipped LAPB parameter file cannot be modified. If you
determine that settings in the factory-shipped file are not suitable for the network to
which this port connects, go to “Creating a LAPB Parameter File” in Chapter 7 and
complete that procedure to create a customized file. Return to step 8 of this
procedure when you finish creating the custom file.

Assign the LAPB parameter file as a port configuration specification.
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Click the Assign button to assign the LAPB parameter file as a configuration
specification for this port. Port configuration specifications are stored in the SX.25
configuration file when you save it using the File menu. If you want to remove a file
that you assigned, click the Delete button.

9. Click OK to confirm this port configuration.

Clicking OK confirms the configuration specifications that you made during the
session, but it does not save your settings to a file. Settings are recorded in an 5X.25
configuration file when you explicitly save them using the File menu.

10. Save your selections in the configuration file.

Use the “Save” option from the File menu to save your configuration selections in
the /etc/config/snetd.options file. If you opened a new file in step 2 of this procedure,
use the “Save As” option instead. (See “Using the File Menu” in Chapter 3 if you
need instructions for saving files.)

The WAN port is now configured. To put the configured port into operation, you must
rebuild the IRIX kernel and stop and restart the network (see “Procedure to Rebuild the
IRIX Kernel” in this chapter and “Using the Action Menu” in Chapter 3 for procedures).
If you have other WAN ports to configure, however, complete those configurations
before rebuilding the kernel.

LAN Port Configuration Procedure

The procedure in this section explains how to configure a port for connection to an X.25
LAN using factory-shipped SX.25 parameter files to specify packet-level and link-level
protocol parameters. However, if you determine that a port requires customized
parameter files (see “Evaluating SX.25 Parameter Files” in Chapter 2 for details), you will
need to perform an additional procedure at step 4 and step 7 to create the necessary files.

Note: If you decide to quit the port configuration procedure before completing it, click
the Cancel button to close the port configuration window and discard your entries.
1. Complete the “Port Selection Procedure” if you have not already done so.

When you select a LAN port using the port selection procedure, the LAN port
configuration window is displayed (see Figure 4-10).
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Figure 4-10  LAN Port Configuration Window

2. Assign a subnet ID to the LAN port.

Select a letter from the list in the Subnet ID field to assign the subnet ID. Use the up
and down arrows to scroll through the list. Your selection may be any letter from A

through Z, but it must be unique to this port (see “Subnet IDs and DTE Addresses”
in Chapter 1 for more information).
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3.

4.

\ General /< Logical Channels /( PacketWindow Sizes /< Timers ‘ Counters

Assign a DTE address to the port.

Enter a DTE address in the DTE Address field to assign a port address. (See “X.121
Addresses” in Appendix A for more information.)

Select an X.25 parameter file to specify the packet-level settings for this port.

Select a file from the X.25 Parameter Files list, based on the port’s function as DTE or
DCE equipment and on the X.25 recommendation implemented on the network. If
you would like to check the settings in the selected file before you assign it to this
port, click the Open button (or double-click on the file) to display file contents. Select
the labeled tabs at the bottom of the window to view additional parameter settings.
To view an unlabeled tab, move the pointer to the unlabeled area and use the right
mouse button to select a tab from a pull down list (see Figure 4-11).

General

Logical Channels
PacketiWindow Sizes
fimers

Fransit Defav

| )4 I | Save As. I | Cancel I | H i gt Lleicts
Closed User Groups

Subseription QOptions
Localization

D-Bit Controf

Throvughpot Window/Packet

Figure 4-11  Tabs of X.25 Parameters

Note: Original X.25 parameter files cannot be modified. If you determine that
settings in the factory-shipped file are not suitable for the network to which this port
connects, go to “Creating an X.25 Parameter File” in Chapter 7 and complete that
procedure to create a customized file. Return to step 5 of this procedure when you
finish.

Assign the selected X.25 file as a port configuration specification.
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Click the Assign button to assign the selected X.25 parameter file as a configuration
specification for this port. Port configuration specifications are stored in the SX.25
configuration file that you save in step 10 of this procedure.

6. Select a LAN link procedure.

Click the checkbox beside LLC1 or LLC2. Enter the service access point, Local SAP
or Loop SAP, as a hexadecimal number.

7. Open an LLC2 parameter file and check its settings.

SX.25 supports connections to Ethernet LANs, FDDI LANs, and token ring LANs.
Select the LLC2 parameter file that corresponds to the physical medium of your
LAN. If you would like to check the settings in the selected file before you assign it,
click the Open button (or double-click on the file) to display file contents. Select the
labeled tabs at the bottom of the window to view additional parameter settings (see
Figure 4-12).

\ General /< Timer /< XD /

| 8] || Save As. || Cancel || Help

Figure 4-12  Tabs of LLC2 Parameters

Note: Original LLC2 parameter files cannot be modified. If you determine that
settings in the factory-shipped file are not suitable for the network to which this port
connects, go to “Creating an LLC2 Parameter File” in Chapter 7 and complete that
procedure to create a customized file. Return to step 8 of this procedure when you
finish creating the custom file.

8. Assign the selected LLC2 file as a port configuration specification.

Click the Assign button to assign the selected LLC2 parameter file as a configuration
specification for this port. Port configuration specifications are stored in the SX.25
configuration file that you save in step 10 of this procedure.



Procedure to Rebuild the IRIX Kernel

9. Click OK to confirm this port configuration.

Clicking OK ends the port configuration session, but it does not record parameter
settings. Settings are not recorded in an SX.25 configuration file until you explicitly
save them (step 10, which follows).

10. Save your selections in the configuration file.

Use the “Save” option from the File menu to save your configuration selections in
the /etc/config/snetd.options file. If you opened a new file in step 2 of this procedure,
use the “Save As” option instead. (See “Using the File Menu” in Chapter 3 if you
need instructions on saving files.)

The LAN port is now configured. The new port goes into operation the next time that you
restart the network (see “The Network Option” in Chapter 3 for information on stopping
and starting the network).

Procedure to Rebuild the IRIX Kernel

The IRIX kernel must be rebuilt whenever you modify a global kernel parameter (see
“Procedure to Configure Global Kernel Parameters”) or a kernel parameter for an
individual port (see “Setting WAN Port Kernel Parameters”). Rebuilding the kernel
requires a temporary shutdown of the SX.25 host; for this reason, you should complete
all changes to kernel parameters before rebuilding the kernel, if possible. To rebuild the
kernel, use options on the Action menu of the SX.25 primary window (see “Using the
Action Menu” in Chapter 3 if you need information on using these options).

Use the procedure below to rebuild the IRIX kernel.

Note: Be sure to make standard host shutdown preparations before you perform this
procedure.

1. Stop network operations using the “Network” option on the Action menu.

2. Rebuild the kernel using the “Create Kernel” option on the Action menu.

3. Reboot the system.

You can reboot the system using the “Restart System” option on the System tool of
your toolchest.

4. Restart the gx25adm utility, if needed.
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By default, the SX.25 application restarts when your system is restarted. If you
disabled this function, you must restart SX.25 before you can perform this step. See
“Starting the gx25adm Utility” in Chapter 3 if you need instructions.

The SX.25 host is now operating with the new kernel parameters that you specified.
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The IP/IXE Option

Configuring X.25 Options

SX.25 offers several options that may be added to the basic X.25 connection service. Some
options affect the SX.25 application globally; these options are accessed from the Edit
menu on the primary window. Other options pertain only to the individual ports where
they are configured; these options are accessed from the Options menu and the Run Time
Stacks menu on the WAN and LAN port configuration windows.

This chapter describes the configuration options that SX.25 offers and explains how to
configure them:

e “The IP/IXE Option”

e “The PVC Map Option”

¢ “Run Time Parameters Option”

e “The IXE Map Option”

¢ “The PAD Map Option”

¢ “The PADD Listen Strings Option”

®  “The Subnetwork Names Option”

Note: To make the procedures in this chapter take effect, you must stop and restart the

network on the SX.25 host. For this reason, you might want to delay the network restart
sequence until you have configured all the options that you plan to use.

Use the IP/IXE option to connect a port on the SX.25 host to an IP network. To support
an IP connection, the IXE driver, which is the interface between the X.25 and the IP
network, needs information about the IP network and the associated X.25 subnetworks
(see “IP Network Connections” in Chapter 1 for more information). You provide this
information by specifying parameter settings in the IP /IXE configuration window
(shown in Figure 5-1).
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Consider implementing the IXE map in conjunction with the IP network connection
service. The IXE map enables hostnames to be entered in network transactions instead of
addresses (see “The IXE Map Option” for instructions).

Note: If you are implementing IP on an unconfigured WAN port, you must rebuild the
IRIX kernel to put the port into operation. Otherwise, you must stop and restart the
network to put the new IP connection into effect.

IP/IXE Configuration Procedure

Follow this procedure to configure a port for an IP network connection:

1.

2.

Complete the “Port Selection Procedure” in Chapter 4.

When you complete the port selection procedure, the WAN or LAN port
configuration window is displayed (see Figure 4-7 or Figure 4-10).

Note: If this is an unconfigured WAN port, complete the instructions in “Setting
WAN Port Kernel Parameters” in Chapter 4 before going on to step 2, below.

Specify the basic connection parameters for the port that you selected.

If this is port is already configured, go directly to step 3 of this procedure. If this is
an unconfigured port, complete steps 2 through 8 of “Creating a WAN Port
Configuration Record” in Chapter 4 or steps 2 through 8 of “LAN Port
Configuration Procedure” in Chapter 4 to configure the port. When you complete
the instructions in Chapter 4, return to step 3, below.



The IP/IXE Option

3. Select the “IP/IXE” option from the Options menu of the port configuration
window.

After your selection, the IP/IXE Configuration parameters window is displayed:

Figure 5-1 IP/IXE Configuration Parameters
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4. Specify IXE driver information in the IP/IXE configuration window.

Refer to the information in “IP/IXE Parameters” for an explanation of the IXE
parameters that must be specified. When you complete the IXE specifications, click
OK on the IP/IXE configuration window to confirm your IXE entries. The IP/IXE
configuration window closes after your confirmation.

5. Click OK on the port configuration window to confirm this port configuration.

Clicking OK confirms the parameter settings for the basic connection service and for
the IP/IXE function on this port. These settings are recorded in the SX.25
configuration file when you save it (step 6, which follows).

6. Save your selections in the configuration file.

Use the “Save” option from the File menu to save your configuration selections in
the /etc/config/snetd.options file. If you opened a new file in step 1 of this procedure,
use the “Save As” option instead. (See “Using the File Menu” in Chapter 3 if you
need instructions for saving files.)

The IP option is configured on this port. It will go into effect the next time you restart the
network (see “The Network Option” in Chapter 3 for instructions). However, if you have
configured IP on a previously unconfigured WAN port, you must rebuild the IRIX kernel
to put the new port into operation (see “Procedure to Rebuild the IRIX Kernel” in
Chapter 4 for instructions).

IP/IXE Parameters

Use this information to determine how to set IP/IXE parameters in the IP/IXE
configuration window:

IP Address Specifies the Internet address of the network to which this port will
connect. Use dotted notation in your entry. The address for a new
network should not duplicate an address that is already in use. (See
Appendix A for address formatting information.)

IP Mask Specifies the subnet mask for this network, which designates the
network portion of the Internet address. Use dotted notation in your
entry.

For example, the mask 255.254.0.0 shows that the network portion of
the address is 15 bits long and the host portion is the remaining 17 bits.
The default subnetwork mask is 255.0.0.0.
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Forward Broadcast Packets

Specifies whether broadcast packets are received or rejected at this port;
a check marks indicates that broadcast packets will be received.

NSDU High Water Mark

Specifies the length at which a data packet, marked with the “More
Data” mark (M-bit), is concatenated into a single network service data
unit (NSDU). Override concatenation by specifying a maximum length.
When the maximum is exceeded, concatenation stops and currently
held data is passed to the Network Service user (with the More
parameter set). Increase this value if you want IP to send or receive
packets of over 576 octets, the default value.

Maximum Idle Time

Specifies the time, in tenths of a second, that a connection on this
network can remain idle before being closed. A timer is configurable for
each X.25 network. When this timer expires, if there is no data on a
connection, the virtual circuit to that network is closed. If data arrives
from IP after the circuit is closed, the circuit is reopened. The default is
30.

Minimum Connection Time

Specifies, in seconds, the minimum time that a connection must remain
open before it can be preempted by another connection. If all X.25
circuits that are available to IXE are in use when an IP packet arrives for
transmission to a new destination, one of the existing connections is
closed. The connection that was idle for the longest time is selected for
closing. The default value is 20.

X.25 mode Specifies whether the network operates in X.25(80), X.25(84), or X.25(88)
mode.
CCITT/DDN Mode

Reset Action

Specifies whether the network uses CCITT or DDN X.25. This is the way
in which IP addresses are mapped onto X.25 addresses, as described in
“IP Network Connections” in Chapter 1.

Specifies how to handle reset requests. Select ACK to acknowledge the
reset and discard it. Select DISC to disconnect the connection in response
to reset requests.
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Expedited Data Action

Specifies how to handle expedited data requests. Select one:

ACK - acknowledge the expedited data but discard it.
DISC - disconnect the connection in response to expedited data.
RESET - reset the connection in response to expedited data (no reset).

PVC Channel Range

Specifies how to handle the logical channels on this port that are
allocated to PVCs. Select Ignore PVC Range Values to ignore all logical
channels allocated to PVCs; or specify Low PVC Value and High PVC
Value, in hexadecimal numbers, to include these PVC channels in the
IXE configuration.

Low and high PVC comprise three hexadecimal digits and must be
separated by a dash (“-”). For example, “009-00b” allocates three IXE
PVC channels.

Listen Information

Sets the application to listen for incoming calls with the specified CUD
fields and called addresses. There are two possible formats:

CUD field, called addresses field;
I|Sbytes | X, I|S D|N semi-octets | X;

The fields in the previous address format signify:

I means “match this field identically”

S means “match this field starting with”

X means “ignore this field”

D means “this field refers to an X.25 DTE”
N means “this field refers to an X.25 NSAP”

This is the last IXE parameter. Return to step 5 of “IP/IXE Configuration Procedure” to
complete the IXE configuration process.

Removing the IP/IXE Service From a Port

To remove the IP/IXE service from a port, display the IP/IXE parameters window
(shown in Figure 5-1; see steps 1 through 3 of “The IP/IXE Option” for details). Click
Clear on the IP /IXE parameters window to remove all IP/IXE information for the port.

To put your changes into effect, stop and restart the network (see “The Network Option”
in Chapter 3 for more information).
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The PVC Map Option

Use the PVC Map option to configure a port to operate with permanent virtual circuits.
Because the default settings in SX.25 parameter files do not provide for PVCs, you must
first create a custom X.25 parameter file that specifies the logical channel ranges for the

PVCs. After you create this file, you can configure the remaining PVC parameters, shown
in Figure 5-2, and use the customized file to store your settings.

Note: If you are implementing PVCs on an unconfigured WAN port, you must rebuild
the IRIX kernel to put the port into operation. Otherwise, you must stop and restart the
network to put new PVCs into effect.

PVC Configuration Procedure

Use this procedure to create an X.25 parameter file and configure PVCs.

1.

Perform the “Port Selection Procedure” in Chapter 4 to select the port for the PVCs.

After your selection, the WAN or LAN configuration window is displayed (see
Figure 4-7 or Figure 4-10).

Note: If this is an unconfigured WAN port, complete the instructions in “Setting
WAN Port Kernel Parameters” in Chapter 4 before going on to step 2, below.

Specity the subnet ID and DTE address if the port is unconfigured.

If this is a configured port, the subnet ID and DTE address are automatically
displayed on the WAN or LAN configuration window, and you can go directly to
step 3. If this is an unconfigured port, these fields are empty; enter the subnet ID
and DTE address of the port where the PVCs will operate; then go on to step 3.

Open an X.25 parameter file to use as a template.

You cannot modify a factory-shipped X.25 parameter file, but you can open an
existing file, specify changes, and save the file under a different name. To open a file,
select the X.25 parameter file that is most appropriate for the port where the PVCs
will operate; then, click the Open button to display the contents of the file.

Select the Logical Channels tab and reset the PVC channel range.

Selecting the Logical Channels tab displays the list of logical channel parameters
and their settings (see Figure 7-3). By default, Low PVC Channel and High PVC
Channel are set to zero. Refer to the information following Figure 7-3 or use the
values recommended by your service provider to reset these values.
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5.

6.

7.

Click the Save As button to record your changes.

The Save As button (shown in Figure 7-1) prompts you to assign the new X.25
parameter file a name. Enter the new filename in the dialog box and click the OK
button.

Notice that the new file is listed in the X.25 Parameter Files list.
Assign the new X.25 parameter file to this port.

Select the new X.25 parameter file and click the Assign button (shown in Figure 4-7
and Figure 4-10) to designate it as the packet-level parameter file to be used on this
port.

Select “PVC Map” from the Options menu to configure the remaining parameters.

After your selection, the PVC Map is displayed (shown in Figure 5-2).
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Figure 5-2 PVC Map Parameters

8. Allocate the logical channels for this port.

To allocate a channel for a PVC, select it and modify the packet-size and
window-size parameters according to the specifications of your network service
provider; then, click the Allocate button. When you finish the channel allocations,
click the Close button to close and save the PVC map and return to the port
configuration window.

9. Specify the link procedure for this port.

Refer to step 6 of “Creating a WAN Port Configuration Record” or the step 6 of
“LAN Port Configuration Procedure” if you need more information on this step.
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10. Specify the LAPB (for WANSs) or LLC2 (for LANs) parameter file for this port.

Refer to step 8 of “Creating a WAN Port Configuration Record” or the step 8 of
“LAN Port Configuration Procedure” if you need more information on this step.

11. Click OK to confirm your settings.

After your entry, the WAN or LAN port configuration screen closes; however, the
PVC configuration is not recorded until you explicitly save it to a configuration file
(step 12, which follows).

12. Save the PVC configuration in an SX.25 configuration file.

To save the PVC information in an SX.25 configuration file, use the “Save” option
from the File menu on the Primary Window; use the “Save As” option from the File
menu if you opened a new file in step 2 of “Port Selection Procedure”. (See “Using
the File Menu” in Chapter 3 if you need instructions for saving files.)

This port is configured for PVCs. It will go into effect the next time that you restart the
network (see “The Network Option” in Chapter 3 for instructions). However, if you
configured PVCs on a previously unconfigured port, you must rebuild the IRIX kernel to
put the new port into effect (see “Procedure to Rebuild the IRIX Kernel” in Chapter 4 for
instructions).

Removing a Permanent Virtual Circuit

To remove a PVC from a port, display the PVC map for the port (shown in Figure 5-2; see
steps 1 through 7 of “The PVC Map Option” for details). Then, select the PVC that you

want to remove and click the Free button. Notice that the PVC is now designated free on
the PVC map.

To put your changes into effect, stop and restart the network (see “The Network Option”
in Chapter 3 for instructions).

Run Time Parameters Option
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A run-time stack provides a means to operate a port using alternate protocol parameters
to test or tune port operation. The port can remain in operation while you configure and
test its run-time parameters. If you wish, you can save the run-time parameters in a file
and use them as the permanent configuration settings for the port.
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Use this procedure to set run-time parameters on a configured port:

1.

Complete the “Port Selection Procedure” in Chapter 4.

Open the configuration file that contains the port’s configuration information
(normally /etc/config/snetd.options); then, select the port from the list of configured
ports. The WAN or LAN port configuration window is displayed after your
selection (see Figure 4-7 or Figure 4-10).

Select a stack from the Run Time Parameters menu.

The Run Time Stacks menu contains two options: “X.25” and “LAPB.” Select “X.25”
to reset packet-level parameters or “LAPB” to reset link-level parameters for
run-time operation.

If you select “X.25,” the X.25 General Parameters window is displayed (see

Figure 7-2). If you select “LAPB,” the LAPB General Parameters window is
displayed (see Figure 7-14). The parameter settings that you see in the general
parameter window are the settings that the port is currently using: settings from the
parameter file that were applied to the port during the previous port configuration
session, or settings that were most recently assigned as run-time parameters.

Set the new run-time parameters for the port.

Adjust the port parameters that require changes. If you need more information, see
“Creating an X.25 Parameter File” in Chapter 7 for resetting packet-level
parameters and “Creating a LAPB Parameter File” in Chapter 7 for resetting
link-level parameters.

Click OK to put the run-time parameters into effect.
The new parameters that you set take effect as soon as you click OK.
Save the run time parameters in a file (optional).

If you decide that you want to save these parameters in a file, click the Save As
button; then, enter the name of the new file in the filename dialog box. If you decide
to use the new parameters permanently, reconfigure the port and apply the new
parameter files in the port configuration procedure (described in the “WAN Port
Configuration Procedure” and the “LAN Port Configuration Procedure” in
Chapter 4).
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Options

The IXE Map Option
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Use the IXE map to enable users to designate IP network hosts by their hostname instead
of their address. This map contains the IP address or hostname of each IP network node
to which the SX.25 host will connect. Hostname entries in the IXE map must appear in
the /etc/hosts file of the SX.25 host. The IXE Map Configuration window, shown in
Figure 5-3, allows you to add, delete, and change IP host entries.

Note: You must stop and restart the network to put a new IXE map into effect.

IXE Map Configuration Procedure

To create the IXE map, follow this procedure:
1. Select the “IXE Map” option from the Edit menu.
After your selection, the IXE Map Configuration window is displayed:

IP Addresses/Host Mames:

e 1 | _J

Figure 5-3 IXE Map of IP Hosts
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2. Click the Add button on the IXE map configuration window.

Clicking the Add button displays the IP/IXE map record, shown in Figure 5-4.

IPAXE Map Record Configuration:

IP Address/Host Hame:

#.25 Address:

Packet Size:

0

Window Size

Figure 5-4 IP/IXE Map Record

3.

Complete a map record for each IP network to which this SX.25 host connects.

Each record associates a port with an IP network by associating the port DTE
address with the IP address of the remote node. The record also specifies the
window and packet size for data exchanges over the connection. Refer to “IP/IXE
Map Parameters” to enter your specifications for each record.

When a record is complete, click OK to record your specifications.
Close and save the IXE map.

When the IXE map contains a record for each IP host, click the Close button on the
IXE Map Configuration window (see Figure 5-3) to close and save the map.

To put the new IP/IXE map into effect, stop and restart the network (see “The Network
Option” in Chapter 3 for instructions).
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IP/IXE Map Parameters

Use this information to determine how to set IP/IXE map parameters:

IP Address/Host Name
Specifies the Internet address of the reciprocating host on the IP
network. You can use the IP hostname instead of its address if the IP
node is listed in the SX.25 /etc/hosts file. See “IP Network
Connections” in Chapter 1 for information on address formats.

X.25 Address  Specifies the DTE address of the port that supports the connection
to the IP network. The DTE address is specified in the port
configuration procedure (see Figure 4-7 and Figure 4-10).

Packet Size Specifies the maximum packet size of incoming and outgoing
datagrams; fragmentation takes place if a packet exceeds the
maximum packet size configured for the port (default packet size is
576 octets). Use the Packet Size option menu to select a packet size.

Window Size  Specifies the maximum window size for incoming and outgoing
data. The valid range is 0 through 127.

Changing the IXE Map

To remove a record from the IXE Map, select an entry on the map and click the Delete
button (see Figure 5-3). To modify information in an IXE map record, select an entry and
click the Edit button. Clicking the Edit button displays the record for the selected entry
and allows you to change it. Click OK to record your changes; then, click Close on the IXE
Map Configuration window to save the IXE map.

Note: To put your changes into effect, stop and restart the network (see “The Network
Option” in Chapter 3 for instructions).

The PAD Map Option
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The PAD map allows users to designate X.25 network hosts by their hostname instead of
their address. This map contains the name, address, and call information for each X.25
network host reciprocating in PAD connections. The address and call information is
automatically supplied in user connection requests. Hostnames can be associated with
aliases. The PAD map configuration window (shown in Figure 5-5) allows you to add,
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delete, and change X.25 host entries. The record that you create for a PAD host comprises
several screens.

Note: You must stop and restart the network to put a new PAD map into effect.

PAD Map Configuration Procedure

To create a PAD map, follow this procedure:
1. Select the “PAD Map” option from the Edit menu on the primary window.
After your entry, the PAD Map Configuration window is displayed:

Host Mames:

| I e [ [ [

Figure 5-5 PAD Map Configuration Window

2. Click the New button on the PAD Map Configuration window.

Clicking the New button displays the first field of the PAD map record, shown in
Figure 5-6. Each record identifies a reciprocating X.25 host and defines its services.

3. Complete a PAD map record for each X.25 network host to which users will connect.

A complete PAD map record comprises four groups of parameters, which are
shown in Figure 5-6 through Figure 5-9. Refer to the parameter descriptions that
follow each figure to enter your specifications for each record.
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4. When a record is complete, click OK to record your specifications.
5. Close and save the PAD map.

When the PAD map contains a record for each X.25 host, click the Close button on
the PAD Map Configuration window (see Figure 5-5) to close and save the map.

The new PAD map is ready to use. To put it into effect, stop and restart the network (see
“The Network Option” in Chapter 3 for instructions).

General Parameters of the PAD Map

The General tab is illustrated in Figure 5-6; its parameters are described in the
information that follows the figure.

Figure 5-6 General Parameters in a PAD Map Record
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Host Name
X.25 Address

X.29 Type

Call User Data

Specifies the name of the X.25 host reciprocating in the connection.

Specifies the X.25 address of the reciprocating host. An X.25 address
comprises four fields (refer to the x25addr(5) reference page or “X.121
Addresses” in Appendix A). The field entries should be separated by a
dot. Only the first field is mandatory for a WAN address. Two fields are
mandatory for a LAN address. Trailing dots may be omitted. This is a
valid X.25 address:

A.234231500010.N.38826110002345678941

Specifies the X.29 protocol to be used in connections. Accept the default
or use the option menu beside the X.29 Type field to reset it to 1980, 1984,
or 1988. The default is the value set in the X.25 parameter file.

Specifies the Call User Data string that is sent in a call request. It may be
of any length up to 124 ASCII characters. If you enter more than 12
characters, fast select is automatically used.

Facilities Parameters of the PAD Map

The Facilities tab is illustrated in Figure 5-7; its parameters are described in the
information that follows the figure.
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Figure 5-7 Facilities Parameters in a PAD Map Record

Incoming and Outgoing Packet Size
Specifies the incoming and outgoing packet sizes. The range for the
parameter is 16 to 4096 bytes.

Incoming and Outgoing Window Size
Specifies the values of the incoming and outgoing window sizes. The
range for the window size is 1 through 127.

Fast Select Specifies whether fast select is in effect (check mark indicates that fast
select is active).

Reverse Call Charges
Specifies whether reverse call charges is in effect (check mark indicates
that reverse call charges is active).
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CUG and RPOA Parameters of the PAD Map

The closed user group (CUG) and recognized private operating agency (RPOA) tab is
illustrated in Figure 5-8; its parameters are described in the information that follows the
figure.

Figure 5-8 CUG and RPOA Parameters in a PAD Map Record

CUG Settings ~ Specifies the user group class. Select Multi-user or Bilateral.

CUG Number Specifies that the call is to be made to the specified Closed User Group
on the specified host. Enter the CUG number (up to four digits).

RPOA Settings Specifies additional routing information about calls to this host to transit
networks. Enter up to four RPOA numbers; each entry consists of four
digits.
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Aliases Parameters of the PAD Map

The Aliases tab is illustrated in Figure 5-9. An alias is any alternative hostname that a
user might enter in connection requests to the host.

Figure 5-9 Alias Parameters on a PAD Map Record

Changing the PAD Map

To remove a record from the PAD Map, select an entry on the map and click the Delete
button (see Figure 5-5). To modify information in a PAD map record, select an entry on
the map and click the Edit button. Clicking the Edit button displays the record for the
selected entry and allows you to change it. Click OK to record your changes; then, click
Close on the PAD Map Configuration window to save the PAD map.

To put your changes into effect, stop and restart the network (see “The Network Option”
in Chapter 3 for instructions).
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The PADD Listen Strings Option

PADD listen strings specify the called addresses and CUD field values for which the
SX.25 application is prepared to accept calls. The PADD Listen String Configuration
window is shown in Figure 5-10.

Note: If you add, delete, or modify a listen string, you must stop and restart the network
to put your changes into effect.
Listen Strings Configuration Procedure

To add PADD listen strings, follow this procedure:
1. Select the PADD option from the Options menu on the primary window.
After your selection, the PADD Listen String Parameters window is displayed:

Figure 5-10  PADD Listen String Parameters
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2. Enter the string in the Listen String field.

See “PADD Listen String Formats,” which follows, for information on entering
listen strings.

3. Click Add to add your entry to the Listen String list.
4. Repeat steps 1 and 2 for each listen string you want to add.

5. Click Close when the list is complete to save the Listen Strings list.

The listen string list is ready to use. To put it into effect, stop and restart the network (see
“The Network Option” in Chapter 3 for instructions).

PADD Listen String Formats

Listen strings restrict the hosts that are allowed to access PAD services on this host. The
strings have two formats:

CUD field, called addresses field,
I| Sbytes | X , I| S D| N semi-octets | X;

The fields in the previous address format signify:

I means “match this field identically”

S means “match this field starting with”

X means “ignore this field”

D means “this field refers to an X.25 DTE”
N means “this field refers to an X.25 NSAP”

For example, suppose the CUD field starts with 01000000; the address field starts with
2342 and contains an X.25 DTE address. The following listen string would be entered:

S01000000, SD2342;

Changing and Removing PADD Listen Strings

To change a PADD listen string, display the PADD Listen String Parameters window
(shown in Figure 5-10), select the listen string that you want to change, and click Clear.
Enter the new listen string and click Add to add it to the Listen String list. When your
changes are complete, click Close to save the modified Listen String list.
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To remove a PADD listen string, display the PADD Listen String Parameters window,
select the listen string that you want to remove, and click Delete to remove it from the
Listen String list.

To put your changes into effect, stop and restart the network (see “The Network Option”
in Chapter 3 for instructions).

The Subnetwork Names Option

As a convenience to users, you can assign names to WAN and LAN subnetworks so that
users can enter a name to designate a subnetwork instead of its address. The
Subnetworks Configuration window (shown in Figure 5-11) allows you to create the
records that associate subnetwork addresses with their name and description.

Note: After you configure subnetwork IDs, you must stop and restart the network to put
your changes into effect.
Subnetwork Names Configuration Procedure

To configure subnetwork names, follow this procedure:
1. Select the “Subnetworks” option from the Edit menu on the primary window.

After your selection, the Subnetworks Configuration window is displayed:
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Figure 5-11  Subnetworks Configuration Window

2. Enter the name, address, and description of the subnetwork.

The subnetwork name is a name that is easily identified by users on the SX.25 host;
the X.25 address is the DTE address that you assigned in the port configuration
procedure (see Figure 4-7 and Figure 4-10) and the description field is any
information about the subnetwork that helps to identify it.

Click the Add button to enter the subnetwork on the Subnetwork Names list.
4. Complete a record for each subnetwork that you want to make available by name.
5. When all subnetwork names are entered, click Close to save the Subnetwork Names

list.

The subnetwork names list is ready to use. To put the list into effect, stop and restart the
network (see “The Network Option” in Chapter 3 for instructions).
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Changing the Subnetwork Names List

To change a subnetwork record, select the subnetwork in the Subnetwork Names field
and click Clear; then enter the new record for the subnetwork. To remove a subnetwork
record, select the subnetwork in the Subnetwork Names list and click Delete (removing a
subnetwork record does not remove the port from service; it simply makes it unavailable
by its subnetwork name). After you make your changes, click Close to save the modified
subnetwork names list.

To put your changes into effect, stop and restart the network (see “The Network Option”
in Chapter 3 for instructions).
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UUCP Configuration

SX.25 provides a mechanism for using the standard UNIX wuucp, cu, and associated
commands over the PAD program by using the xty device driver. The xty device behaves
like a tty device that supports both blocking and non-blocking opens of the same logical
device. It can support gettys for incoming calls that make a blocking open on the xty
device.

This chapter provides information on these UUCP topics:

¢ “Configuring the XTY System”
¢ “Files Associated with UUCP”

Configuring the XTY System

SX.25 supports a STREAMS interface called the XYT_OUT system, which uses the xty
STREAMS module only for outgoing uucp/cu calls. This type of system does not require
getty processes. Incoming calls are handled directly by the PAD daemon that executes the
login process.

Files Associated with UUCP

A number of files need modification before uucp/cu type calls can be made over the xty
driver. These files and their uses are described below. All these files can be found in the
directory /usr/lib/uucp. For detailed information on individual files, refer to IRIX Admin:

Networking and Mail.
Devices Specifies which xty devices are available for outgoing calls.
Dialcodes Specifies a number of host-to-5X.25 address mappings.
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Permissions Specifies permissions that remote users have when sending files,
whether local users can request files, and which commands users are
allowed to use.

Caution: System security can be compromised if Permissions is
incorrectly configured.

Dialers Specifies the command that uucp issues to the pad program to make a
uucp call.

Systems Specifies the hosts that uucp knows about. It includes login names and
character sequences that uucp is to send and expects to receive as
responses.

These files would have the format presented below for a typical UUCP-over-X.25
configuration.

Devices

Typically, one line is entered for each outgoing xty device. Lines like the following should
be added to the Devices file:

Pad xty80 - 9600 pad
Pad xty81 - 9600 pad
Pad xty82 - 9600 pad
Pad xty83 - 9600 pad

Dialcodes

The new entries in the Dialcodes file specify a name to X.25 address mapping. This name
is used in the Permissions and Systems files. Lines like the following should be added to
the Dialcodes file:

hostnamel A. 1234567891
hostname2 A. 1234567892
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Permissions

Lines like the following should be added to the Permissions file:

MACHI NE=hostnamel: hostname2 \
REQUEST=yes \

SENDFI LES=yes \

READ=/ WRI TE=/ \
COMIVANDS=AL L
LOGNAME=Nnuucp \
REQUEST=yes \

SENDFI LES=yes \

READ=/ WRI TE=/ \
COMVANDS=AL L

Note: These permissions let users do almost anything, so you may need to be more
restrictive. For more detail, refer to IRIX Admin: Networking and Mail.
Dialers

The added entry in this file tells uucp the command to issue to the pad program to allow
outgoing calls. Add the following line to the Dialers file:

pad "" "" CALL\sS\T

Systems

Add lines like the following to the Systems file:

hostnamel Any Pad 9600 hostnanel "" \\r\\d\\r in:--in: nuucp
hostname2 Any Pad 9600 hostnane2 "" \\r\\d\\r in:--in: nuucp
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Creating Customized Parameter Files

In most cases, the protocol parameter files that SX.25 provides are appropriate for X.25
WANSs and LANS, so it is not necessary to create customized parameter files. However,
if you determined that the settings in the factory-shipped parameter files do not meet
your connection requirements (see “Evaluating SX.25 Parameter Files” in Chapter 2 for
details), you need to perform the procedures in this chapter. These procedures explain
how to use factory-shipped files as templates to create your own custom parameter files.

Note: Factory-shipped SX.25 parameter files cannot be modified. To create a custom file,
you open a factory-shipped file, make your changes, and save them in a new file under

a different name.

This chapter contains three procedures for creating configuration files:
* “Creating an X.25 Parameter File”

* “Creating a LAPB Parameter File”

* “Creating an LLC2 Parameter File”

Using Parameter Files as Templates

The contents of X.25, LAPB, and LLC2 parameter files are displayed in a series of
windows that you use as templates to create custom parameter files. Each template
contains a logical grouping of protocol parameters (such as LLC2 timer parameters) and
input widgets for specifying custom settings (such as option menus and sliders). In
addition, the lower of edge of a template contains tabs and buttons for controlling the file
creation process.

Template Tabs

When you open a protocol parameter file, the General parameters tab is displayed. Use
the labeled tabs at the lower edge of the window to display a different group of
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parameters. If the parameters that you wish to display do not appear on a labeled tab,
move the pointer to the unlabeled tab area and use the right mouse button to select a tab
from a pull-down list, as shown in Figure 7-1.

General

Logical Channefs
PacketWindow Sizes
fimers

\ General /< Logical Channels /< PacketWindow Sizes /< Timers ‘ Counters
Fransit Delay

| Ok I | Save As... I | Cancel I | || Throughput Class
Closed User Groups

Subscription Options
Localization

D-Bit Controf

FThroughput Window/Packet

Figure 7-1 Unlabeled Tabs on Template Windows

The OK Button

Use the OK button to record changed settings in a previously-created custom parameter
file. (You cannot use OK to write to a factory-shipped file; see “The Save As Button.”).
Clicking OK confirms your changes and closes the custom file, but it does not save the
modified version of the file. The modified parameter file is permanently saved when you
save the configuration file (normally, this is done at the end of the port configuration
procedure).

The Save As Button

Use the Save As button to record your changes to a factory-shipped file in a custom
parameter file. When you click Save As, you are prompted to enter a name for the new
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custom file. Entering a name for the new custom file does not save it. The file is
permanently saved when you save the configuration file (normally, this is done at the
end of the port configuration procedure).

The Cancel Button

Use the Cancel button to close the parameter file and discard your entries. When you click
Cancel, no changes are made to the parameter file; any information that was in the file
from previous sessions remains unchanged.

The Help Button

Use the Help button to get information about using parameter windows.

Creating an X.25 Parameter File

Use the procedure below to create a custom X.25 parameter file for a WAN or LAN port.
This procedure assumes that you completed steps 1 through 3 of either “Creating a WAN
Port Configuration Record” (for WAN ports) or “LAN Port Configuration Procedure”
(for LAN ports) in Chapter 4. It also assumes that you plan to use a factory-shipped file
as a template for the custom file, but you can also use a previously-created custom file as
a template.

1. Open a factory-shipped X.25 parameter file.

To open a factory-shipped file, select a file from the X.25 Parameter Files list, based
on the port’s function as DTE or DCE equipment and on the X.25 recommendation
implemented on the network. Click the Open button (or double-click on the file) to
display file contents. Click on the labeled tabs at the bottom of the window to view
additional parameter settings. To view an unlabeled tab, move the pointer to the
unlabeled area and use the right mouse button to select a tab from a pull down list
(see Figure 7-1).

2. Modify the settings that need changing.

The contents of X.25 parameter files comprise several windows. Figure 7-2 through
Figure 7-13 illustrate X.25 protocol parameters and their factory-shipped settings;
see the information that follows each figure for information about the parameters
that the figure contains. Use the values specified by your network service provider
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3.

4.

or your knowledge of the operating characteristics of your network to change X.25
parameter settings. When you finish your changes, return to step 3 of this
procedure.

Create a new X.25 parameter file under a different name to save your settings.

You cannot modify the original X.25 parameter file, but you can create a modified
version of the original file and save it under a different name. To save your changes
to X.25 parameter settings, click the Save As button; then, enter the name of the new
file in the filename dialog box.

Notice that the new X.25 file appears in the X.25 Parameter Files list and that the
new file is selected.

Return to step 5 of “Creating a WAN Port Configuration Record” or “LAN Port
Configuration Procedure” in Chapter 4 to continue the configuration process.

X.25 General Operating Parameters

Figure 7-2 illustrates the panel of general operating parameters for X.25. Each parameter
is explained in the information that follows the figure.

=.§ gu2dadm:WAN X.25 Template def.dee80.x25

MNetwork Protocol Mode:
X.25 Version: 80 =

Level 3 PLP Mode:
Sequence Mumbering Option:

Figure 7-2 X.25 General Parameters
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Network Protocol Mode
Specifies the characteristics of the network protocol. For example, a
value “X25_LLC” specifies either 1984 or 1988 X.25 over LLC2
procedures. Use the option popup menu beside the Network Protocol
Mode parameter to make your selection.

X.25 Version  Specifies the X.25 protocol recommendation used on the network. Use
the option popup menu beside the X.25 Version parameter to make your
selection.

Note: Selecting X25_LLC as the network protocol mode sets an X.25(80)
selection in this field to X.25(84).

Level 3 PLP Mode
Specifies whether the port will function as a DTE or DCE. Use the option
popup menu beside the Level 3 PLP Mode parameter to make your
selection.

Sequence Numbering Option
Sets sequence numbering to Modulo 8 or Modulo 128. Use the option
popup menu beside the Sequence Numbering parameter to make your
selection.
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Logical Channel Parameters

Figure 7-3 illustrates the panel of logical channel parameters for X.25 and their default
settings. Channel parameters are explained in the information that follows the figure.

=.§ gu2dadm:WAN X.25 Template def.dee80.x25

Low PVC Channel Humber {(Hex):
High PYC Channel Humber (Hex):
Low Incoming Channel Humber {(Hex):

High Incoming Channel Humber (Hex):

=l 1 E

Low Incoming Two-way Channel Humber {(Hex): 488
High Incoming Two—way Channel Humber (Hex): 43F

Low Qutgoing One—-way Channel Mumber (Hex): A

]

High Outgoing One-way Channel Humber (Hex): | B

Figure 7-3 Logical Channel Parameters

In a DTE/DTE environment, one DTE sees the range of lowest incoming logical channels
as presented in Figure 7-3. The other DTE sees these ranges from the viewpoint of a DCE.
For example, it views the range from lowest incoming logical channels to highest
incoming logical channels as one-way outgoing.

The numbers of logical channels of each type are calculated from the values of the pairs
of parameters:

Number of PVCs = Highest PVC - Lowest PVC + 1

Note: If highest and lowest logical channels are both set to zero, no channels are
allocated in that grouping.
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These parameters specify logical channel functions:

Low and High PVC Channel Number
Specifies the range of channels to be allocated to permanent virtual
circuits.

Low and High Incoming Channel Number
Specifies the range of channels to be allocated for receiving inbound
calls only.

Low and High Two-way Channel Number
Specifies the range of channels to be allocated for receiving inbound
calls and sending outbound packets.

Low and High Outgoing Channel Number
Specifies the range of channels to be allocated for sending outbound
calls only.
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Packet- and Window- Size Parameters

Figure 7-4 illustrates the panel of packet-size and window-size parameters for X.25. Each
parameter is explained in the information that follows the figure.

Figure 7-4 Packet- and Window-Size Parameters
Local and Remote Maximum Packet Size

Specifies the maximum size for outbound packets; remote maximum
packet size specifies the maximum size for inbound packets.
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Use these parameters to set the maximum size of data packets that are
acceptable on the X.25 link. On any incoming call, a value for the
packet-size parameter greater than the lowest outgoing logical channel
(shown in Figure 7-3) or remote maximum packet size is negotiated
down to this value when the call is accepted.

Note: Be sure that lowest outgoing logical channel is greater than the
frame size that you set for the underlying protocol: the LAPB I frame on
the WAN or the LLC-2 I frame on the LAN. The I frame size is set in the
LAPB template (shown in Figure 7-14) or the LLC2 template (shown in
Figure 7-17).

Local and Remote Default Packet Size
Specifies the default size for outbound packets; remote default packet
size specifies the default size for inbound packets.

Use this parameter to specify the default packet size for a particular
network. The standard value is 7, which sets a default data packet size
for each direction of transmission to 128 octets (27, that is, 1 << 7). The
value may be nonstandard if it is agreed between all communicating
parties on the LAN or between the DTE and DCE.

Local and Remote Maximum Window Size
Specifies the maximum size of windows for outgoing calls; remote
maximum window size specifies the maximum size of windows for
incoming calls.

Use this parameter to specify the maximum window size acceptable on
the subnetwork. On any incoming call, a window size value greater
than lowest outgoing logical channel (shown in Figure 7-3) or remote
maximum window size is negotiated down to this value when the call
is accepted. For Modulo 8 networks, the range for lowest outgoing
logical channel or remote maximum window is 2 through 7, and for
Modulo 128 the range is 2 through 127.

Local and Remote Default Window Size
Specifies the default size of windows for outgoing calls; remote default
window size specifies the default size of windows for incoming calls.

Use this parameter to specify the value of the default window size for a
particular network. The standard value is 2. The value may be
nonstandard provided it is agreed between all communicating parties
on the LAN, or between the DTE and DCE.
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Note: The sequence numbering scheme, modulo 8 or modulo 128
(shown in Figure 7-2), affects the range of this parameter. For modulo 8
networks, the range for lowest outgoing logical channel (shown in
Figure 7-3) or remote default window size is 1 through 7, and for
modulo 128 the range is 1 through 127.

Maximum NSDU Length
Specifies the maximum length of a network service data unit (NSDU).
SX.25 tries to concatenate data packets marked with the “More Data”
mark (M-bit) into a NSDU. However, you can specify a maximum length
to avoid running out of buffers. When this maximum is exceeded,
concatenation stops and currently held data is passed to the network
service user with the M-bit set. Applications can override this parameter
for specific circuits using the nsdulimit field of the Quality Of Service
parameter on Connect Requests and Connect Confirmations. The
default value for this parameter is 256; the maximum value is 32,000.

Timer Parameters

Figure 7-5 illustrates the tab of timer parameters for X.25. Notice that timer parameter
names are descriptive of their function. For parameters known by a mnemonic
equivalents, the mnemonic is given in parentheses in the descriptions that follow. All
timer values are measured in tenths of a second except where noted.
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Figure 7-5 Timer Parameters

Acknowledgement Delay
Specifies the maximum time during which a pending acknowledgement
is withheld. SX.25 attempts to suppress the generation of Level 3 Receive
Ready control packets. Acknowledgment carried by data or multiple
acknowledgements is preferred to each data packet being explicitly and
separately acknowledged. The permitted range is .1 to 3200.
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Restart Request Response Timer
(T20) The default value is 180, the permitted range 0 to 3200.

Call Request Response Timer
(T21) The default value is 200, the permitted range 0 to 3200.

Reset Request Response Timer
(T22) The default value is 180, the permitted range 0 to 3200.

Clear Request Response Timer
(T23) The default value is 180, the permitted range 0 to 3200.

Window Status Transmission Timer
(similar to T24) Specifies the maximum interval during which data
received from the remote transmitter can remain unacknowledged due
to a flow control condition. After this timer expires, any outstanding
acknowledgements are carried by an X.25 Level 3 Receive-Not-Ready
packet. Use this timer to ensure that if the remote transmitter does not
receive an acknowledgement, this does not cause resets within the
virtual circuit. This timer should be approximately half the value set for
the window rotation timer.

The default value is 75, the permitted range 0 to 3200.

Window Rotation Timer
(T25) This timer should be approximately twice the value set for the
window status transmission timer. The default value is 150, the
permitted range 0 to 3200.

Interrupt Response Timer
(T26) The default value is 180, the permitted range 0 to 3200.

LAN Idle Connection Timer
Specifies the period for maintaining a link-level connection when there
is no reciprocating connections. If the link is to a WAN, set the value to
zero (that is, infinity). This timer is appropriate only when running X.25
over the LAN.

The default LAN value is 60; the default WAN value is 0. For both, the
permitted range is 0 to 3200.

Resolution Timer
Specifies the interval during which the DTE/DCE resolution should be
completed. This prevents two packet-level entities failing to resolve
their DTE/DCE nature. When this timer expires, the link connection is
disconnected and all pending connections are aborted.
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The default value is 200; the permitted range 0 to 3200.

Counter Parameters

Figure 7-6 illustrates the panel of counters parameters for X.25. Each parameter is
explained in the information that follows the figure.

1
e

DTE Restart Request Retransmission Count

‘

DTE Reset Request Retransmission Count

‘

DTE Clear Request Retransmission Count

Figure 7-6 Counter Parameters

DTE Restart Request Retransmission Count
(R20) The default value is 1; the permitted range 1 to 255.

DTE Reset Request Retransmission Count
(R22) The default value is 1; the permitted range 1 to 255.

DTE Clear Request Retransmission Count
(R23) The default value is 1; the permitted range 1 to 255.
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Transit Delay Parameters

Figure 7-7 illustrates the panel of transit delay parameters for X.25. Each parameter is
explained in the information that follows the figure.

=.§ gu2dadm:WAN X.25 Template def.dee80.x25

.005
| = 1

Local Delay

.005
| = 1

Access Delay

Figure 7-7 Transit Delay Parameters

Local Delay  Specifies the transit delay that results from internal processing.

Access Delay  Specifies the transit delay that results from the line transmission rate.
The default for both parameters is .005; the permitted range O to 32.

Throughput Class Parameters

Figure 7-8 illustrates the panel of throughput class parameters for X.25. Each parameter
is explained in the information that follows the figure.
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=.§ gu2dadm:WAN X.25 Template def.dee80.x25

Local Maximum Throughput Class

Remote Maximum Throughput Class

Local Default Throughput Class

Remote Default Throughput Class
3

1 | |

Local Minimum Throughput Class

3

1 | |

Remote Minimum Throughput Class

Figure 7-8 Throughput Class Parameters

Be sure to observe the following points when you set these parameters:

¢ The value of local maximum throughput class and remote maximum throughput
class should be greater than or equal to that of local default throughput class and

remote default throughput class, respectively.

¢ The value of local default throughput class and remote default throughput class
should be greater than or equal to that of local minimum throughput class and

remote minimum throughput class, respectively.

Local and Remote Maximum Throughput Class
Defines the maximum packets size for each transmission direction: local
maximum throughput class specifies the maximum size for outbound
packets; remote maximum throughput class specifies the maximum size

for inbound packets.

These parameters are the maximum supported value of the throughput
class Quality Of Service parameter. ISO 8208 specifies a value for lowest
outgoing logical channel (shown in Figure 7-3) or remote maximum
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throughput class in the range of 3 through 12, corresponding to a range
of 75 to 48,000 bps. However, the supported valid range is 0 to 15. This
accommodates nonstandard X.25 implementations that use the
Throughput Class parameters to map to packet/window sizes (see
“Throughput Window and Packet Parameters”).

Local and Remote Default Throughput Class

Defines the default packet sizes for each transmission direction: local
default throughput class specifies the default size for outbound packets;
remote default throughput class specifies the default size for inbound
packets.

In some networks (TELENET, for example), negotiation of throughput
class is towards a configured default throughput class. In such cases,
the negotiate throughput class parameter (shown in Figure 7-13) is
non-zero and lowest outgoing logical channel (shown in Figure 7-3) or
remote default throughput class is the default. In other PSDNs, you
should set lowest outgoing logical channel or remote default
throughput class to the value of lowest outgoing logical channel or
remote default throughput class.

Local and Remote Minimum Throughput Class

Defines the minimum packet sizes for each transmission direction: local
minimum throughput class specifies the minimum size for outbound
packets; remote minimum throughput class specifies the minimum size
for inbound packets.

According to ISO 8208, the throughput class parameter is defined in the
range of 3 through 12. Some PSDNs may provide a different mapping,
in which case lowest outgoing logical channel (shown in Figure 7-3) or
remote minimum throughput class is the minimum value.
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Closed User Group Parameters

Figure 7-9 illustrates the panel of closed user group (CUG) parameters for X.25. To
change a CUG parameter, click the check box beside it to turn the parameter on or off.
Use the option menu beside the “CUG Format” parameter to select either basic or
extended CUG format.

Note: Some networks, such as DDN, require you to set the flag to reject incoming calls
carrying any closed user group optional facility.

=.§ gu2dadm:WAN X.25 Template def.dee80.x25

[ Subscribe to CUGS without incoming or outgoing access
(L] subscribe to preferential ClIGs
[L1 Subscribe to CUGSs with outgoing access

(L] subscribe to CUGS with incoming access

CUG Format: Basic Format = |

[_] Reject incoming calls containing any CUG facility

Figure 7-9 Closed User Group Parameters
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Subscription Option Parameters

Figure 7-10 illustrates the panel of subscription option parameters for X.25. To change a
subscription parameter, click the check box beside it to turn the parameter on or off.

Note: Subscribing to extended call packets enables window- and packet-size
negotiation, which permits the exchange of extended call packets. Treating extended
incoming call packets as a procedure error prevents the exchange of extended call
packets.

Figure 7-10  Subscription Options Parameters
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Localization Parameters

Figure 7-11 illustrates the panel of localization parameters for X.25, which are used to
tune options for a particular subnetwork. Each parameter is explained in the information
that follows the figure.

Figure 7-11  Localization Parameters

International Call Recognition
Governs whether outgoing international call requests are to be
recognized and how. Use the popup option menu beside the
International Call Recognition parameter to select one of these settings:
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Priority Encode

Source Address

Not distinguished: international calls are not distinguished.

DNIC mismatch: the data network identification code (DNIC) of
the called DTE address is examined and compared with that held in
psdn_local members dnicl and dnic2. A mismatch implies an
international call.

DTE prefix of 1: International calls are distinguished by a 1111
prefix on the DTE address (DATAPAC, among others, use this
feature).

DTE prefix of 0: International calls are distinguished by a 0000
prefix on the called DTE address. This feature is generally used in
conjunction with the Priority Encode Control parameter.

Control

Governs how priority requests are to be encoded for this PSDN. Use the
popup option menu beside the Priority Encode Control parameter to set
the value according to the following:

The priority is encoded according to X.25(88).

DATAPAC Priority Bit: Encode the priority request using the
DATAPAC Priority Bit (1976 version).

DATAPAC Traffic Class: Encode the priority request using the
DATAPAC Traffic Class (1980 version employing the Calling
Network facility marker).

Control

Overrides or sets the calling address in outgoing call requests for this
PSDN. Use the popup option menu beside the Source Address Control
parameter to set the value according to the following:

No Action: Calling DTE addresses are encoded as if provided by
the network service user.

Omit Calling DTE Address: address of the calling DTE is omitted
even if the network service user supplied one.

Use Local DTE Address: If the network service user does not
supply a DTE address, use the configured DTE address for this
PSDN (which can be NULL).

Calling DTE is Local DTE: Use the local DTE address even if the
network service user supplied a calling DTE address.
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Priority Packet Forced Value
Sets the packet size on all priority call requests and incoming calls to the
value specified in this parameter.

Data Network Identification Code
Contains the first four BCD digits of the DNIC and is used only when
international call recognition is set.

Prioritize International Calls
Specifies whether a prioritization method is to be used for international
calls (assuming that the PSDN supports such a feature). Use this
parameter in conjunction with two other parameters: priority encode
control and priority packet forced value.

Subnetwork Modes
Specify network tuning options for treatment of diagnostic packets and
other functions. You can control these functions by setting indicators on
or off. Click on the selection box beside an indicator to set it; a check
mark indicates that an indicator is on.

D-Bit Control Parameters

The X.25 standard does not give specific recommendations for handling the D-bit. To
provide flexibility to accommodate local PSDN requirements, SX.25 lets you specify how
the D-bit should be handled. Figure 7-12 illustrates the panel of D-bit control parameters
for X.25. Each parameter is explained in the information that follows the figure.

=.§ gu2dadm:WAN X.25 Template def.dee80.x25

D-Eit Action on ACCEPT-IM: Clear the Calf =

D-Eit Action on ACCEPT-0OUT: Clear the Calf =

D-Eit Action on DATA-IN: Reset the Calf =

D-Eit Action on DATA-OUT: Reset the Calf =

Figure 7-12  D-Bit Control Parameters
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Use the popup option menu beside each D-bit control parameter to select a new value for
the parameter. Your choices for D-bit parameters are Clear the Call, Zero the D-bit, or No
Action.

D-Bit Action on ACCEPT-IN
Defines what happens during the call setup phase if a Call Accept is
received and there is no local D-bit support.

D-Bit Action on ACCEPT-OUT
Defines what happens during the call setup phase if a Call Accept is sent
and there is no request for D-bit from the other end.

D-Bit Action on DATA-IN
Defines what happens when a data packet is received and there is no
request for the D-bit from the local user.

D-Bit Action on DATA-OUT
Defines what happens when a data packet is sent and there is no
indication of D-bit support from the remote party.

Throughput Window and Packet Parameters

Some implementations of X.25 do not use the X.25 packet and window negotiation
function. Instead, these implementations use throughput class window and packet
mapping to determine window and packet sizes. Figure 7-13 illustrates the panel of X.25
throughput class parameters. Each parameter is explained in the information that
follows the figure.
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=.§ gu2dadm:WAN X.25 Template def.dee80.x25

[L1] Wegotiate Throughput Class

Throughput Class Type: | Mo Action = |

Window Mapping: | ©.0.6.8.8.0.0.6.6.6.0.0.0.8.8.0 I

Packet Mapping: | 0.0.6.6.0.0.6.5.0.0.0.6.6.0.0.0 I

Figure 7-13  Throughput Window and Packet Parameters

Negotiate Throughput Class
Specifies whether to negotiate throughput class towards the defaults,
which are specified by the lowest outgoing logical channel (shown in
Figure 7-3) and the remote default throughput class (shown in
Figure 7-4).

Click on the check box to set this parameter on for networks like
TELENET, which require negotiation of the throughput class towards
those defaults. When this parameter is off (the default), throughput
class is negotiated according to the X.25 procedures instead.

Throughput Class Type
When set to a value other than No Action, specifies the way in which
window and packet sizes are mapped. The values of lowest outgoing
logical channel (shown in Figure 7-3) and remote maximum throughput
class (shown in Figure 7-4) may limit the range of the mapped values.
The value that you select for this parameter applies to both transmission
directions.

Keep these points in mind when setting this parameter:

* Do not select the Use Low Nibble, Use High Nibble, or Use Both
Nibbles value if window and packet size negotiation are necessary:
this algorithm is designed for PSDNSs that support the mapping
procedure only.

105



Chapter 7: Creating Customized Parameter Files

106

® In call requests, specify equal values for local throughput and
remote throughput in the qosformat, to ensure that low nibble and
high nibble values behave correctly.

® Selecting the Use Low Nibble or Use High Nibble value prevents
users and applications from negotiating window and packet size.

¢ If you select the Use Both Nibbles value, users can negotiate
window and packet sizes only through the throughput class
parameter.

* If you subscribe to the extended facility option and you select the
Use Both Nibbles value, negotiation using flow negotiation
parameters is overridden.

¢ Because window and packet size negotiation is suppressed when
you use window and packet mapping, it is important that your
entries for the window mapping parameter and packet mapping
parameter are correct for your PSDN. This ensures that both called
and calling parties agree on the values associated with a particular
throughput class.

Window Mapping

Maps the value of the throughput class for each direction of
transmission to a window parameter. This value is a number from 0 to
15 (a value of zero for any individual value is interpreted as the default
value for the subnetwork). The permitted range is between 1 and the
value of either the lowest outgoing logical channel or the remote
maximum window size; the maximum possible value is 127. The
maximum for the subnetwork is the smaller of two values: lowest
outgoing logical channel parameter or remote maximum window size
parameter.

Packet Mapping

Maps the value of the throughput class for each direction of
transmission to a packet parameter. This value is a number from 0 to 15.
(a value of zero for any individual value is interpreted as the default
value for the subnetwork). The permitted range is between 1 and the
value of either the lowest outgoing logical channel or the remote
maximum window size; the maximum possible value is 127. The
maximum for the subnetwork is the smaller of two values: lowest
outgoing logical channel parameter or remote maximum window size
parameter.
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These are the last X.25 parameters. Return to step 3 of “Creating a LAPB Parameter File”
to continue the file creation process.

Creating a LAPB Parameter File

Use the procedure in this section to create a custom LAPB parameter file. This procedure
assumes that you completed steps 1 through 6 of “Creating a WAN Port Configuration
Record” in Chapter 4. It also assumes that you plan to use a factory-shipped file as a
template for the custom file, but you can also use a previously-created custom file as a
template.

1.

Open the factory-shipped LAPB parameter file.

To open a factory-shipped file, select the file from the LABP Parameter File list and
click the Open button (or double-click on the file) to display its contents. Click on the
labeled tabs at the bottom of the window to view additional parameter settings.

Modify the settings that need changing.

The contents of the LAPB parameter file comprise several windows. Figure 7-14
through Figure 7-16 illustrate LAPB protocol parameters and their factory-shipped
settings; see the information that follows each figure for information about the
parameters that the figure contains. Use the values specified by your network
service provider or your knowledge of the operating characteristics of your network
to change LAPB parameter settings. When you finish your changes, return to step 3
of this procedure.

Create a new LAPB parameter file under a different name to save your settings.

You cannot modify the original LAPB parameter file, but you can create a modified
version of the original file and save it under a different name. To save your changes
to LAPB parameter settings, click the Save As button; then, enter the name of the
new file in the filename dialog box.

Notice that the new file LAPB appears in the LAPB Parameter Files list and that the
new file is selected.

Return to step 8 of “Creating a WAN Port Configuration Record” to continue with
the port configuration process.

107



Chapter 7: Creating Customized Parameter Files

LAPB General Operating Parameters

Figure 7-14 illustrates the panel of general operating parameters for LAPB. Each
parameter is explained in the information that follows the figure.

Figure 7-14  LAPB General Parameters

Maximum Number of Transmissions
Specifies the maximum number of times that a PDU is sent after the
Acknowledgment Timer, the P-bit timer, or the Reject Timer expires. It
also limits the number of times Receive Ready with P-bit set is sent when
the remote is busy and the Busy Timer expires.

The default value is 65 and the permitted range is 1 to 255.
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Maximum Number of Unacknowledged IPDUs

Specifies the maximum number of unacknowledged IPDUs that can be
received before the Reset Request acknowledging them must be sent.

The default value is 12 and the permitted range is 0 to 127.

Transmit Window Size

Transmit Probe

The number of unacknowledged IPDUs that LAPB can send.

In normal mode, when Modulo 8 sequence numbering is used, the
default value is 7 and the permitted range is 1 to 7.

In extended mode when Modulo 128 sequence numbering is used, the
default value is 7 and the permitted range is 1 to 127.

The position before the window is closed at which an IPDU, with the
P-bit set, is sent to ask for an acknowledgement from the receiver.

In normal mode when Modulo 8 sequence numbering is used, the
default value is 0 and the permitted range is 0 to 7.

In extended mode, when Modulo 128 sequence numbering is used, the
default value is 0 and the permitted range is 0 to 127.

Maximum Size of LAPB I frame

Specifies the maximum size of incoming I frames; I frames above the
specified size are rejected by an FRMR. The size is equal to this sum:

maximum X.25 data size + X.25 protocol length + LAPB protocol length

The default value is 261. Permitted values are: 261 to 263, 517 to 519,
1029 to 1031, 2053 to 2055, and 4101 to 4103.

109



Chapter 7: Creating Customized Parameter Files

LAPB Timer Parameters

Figure 7-15 illustrates the panel of timer parameters for LAPB. Each parameter is
explained in the information that follows the figure. Unless noted otherwise, LAPB timer
values are expressed in tenths of a second.

7.1
I

Acknowledgement Timer

i-\l

P-Bit Timer
25

Reject Timer

10.0

Busy-state Timer

2909

Link Idle Timer
22

taximum Delay Before Sending RR

Figure 7-15  LAPB Timer Parameters

Acknowledgement Timer
Specifies the time during which the LAPB expects to receive an
acknowledgement to an outstanding IPDU or an expected response to a
sent unnumbered PDU.

The default value is 7.1 and the permitted range is .1 to 300.

P-Bit Timer
Specifies the time during which the LAPB expects to receive a PDU with
the F-bit set to 1 in response to a command with the P-bit set to 1. This
value should be less than that specified for the Acknowledgment Timer.

The default value is .7 and the permitted range is .1 to 300.
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Reject Timer
Specifies the time during which the LAPB expects to receive a reply to a
sent RE] TPDU.

The default value is 2.5 and the permitted range is .1 to 1000.

Busy-state Timer
Specifies the time during which the LAPB waits for an indication of the
clearance of a busy condition at the other LAPB.

The default value is 10.0 and the permitted range is .1 to 3000.

Link Idle Timer
Specifies the time during which the LAPB expects to receive a PDU from
the other LAPB. If it expires, the P/F cycle is initiated, which may result
in link disconnection. A value of zero disables this function.

The default value is 29.9 and the permitted range is 0 to 3200.

Maximum Delay Before Sending RR
Specifies the maximum delay in tenths of a second before transmitting a
delayed RR (Reset Request). This must be considerably less than the
Acknowledgment Timer value.

The default value is 2.2 and the permitted range is 0 to 300.
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LAPB Link-Level Parameters

Figure 7-16 illustrates the panel of link-level parameters for LAPB.

=.§ g2dadm Il APE Template Configuration def faph

Error State Indicators:

[L1 Ignore any UA Frames received
(L] Retransmit Frame-reject if one is received

[L1] Transmit a Frame—reject if an invalid frame response is received
Other indicators:

[ Transmit Frame-reject when 5-Frame is received without the P—hit

[] Do not transmit a DM on entry to ADM state

Figure 7-16  LAPB Link-Level Parameters

Error State and Other Indicators
These parameters control LAPB conformance tuning by defining its
operation in certain states. You can control state operations by setting
error state indicators on or off. Click the check box beside an indicator to
set it; a check mark indicates that an indicator is on.

These are the last LAPB parameters. Return to step 3 of “Creating a LAPB Parameter
File” to complete the file creation process.
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Creating an LLC2 Parameter File

Use the procedure below to create a custom LLC2 parameter file. This procedure
assumes that you completed steps 1 through 5 of the “LAN Port Configuration
Procedure” in Chapter 4. It also assumes that you plan to use a factory-shipped file as a
template for the custom file, but you can also use a previously-created custom file as a
template.

1.

Open the factory-shipped LLC2 parameter file.

To open a factory-shipped file, select the file from the LLC2 Parameter File list that
is appropriate for the type of media on the LAN where this port will connect. Click
the Open button (or double-click on the file) to display file contents. Click on the
labeled tabs at the bottom of the window to view additional parameter settings.

Modify the settings that need changing.

The contents of the LLC2 parameter file comprise several windows. Figure 7-17
through Figure 7-19 illustrate LAPB protocol parameters and their factory-shipped
settings; see the information that follows each figure for information about the
parameters that the figure contains. Use the values specified by your network
service provider or your knowledge of the operating characteristics of your network
to change LLC2 parameter settings. When you finish your changes, return to step 3
of this procedure.

Create a new LLC2 parameter file under a different name.

You cannot modify the original LLC2 parameter file, but you can create a modified
version of the original file and save it under a different name. To save your changes
to LLC2 parameter settings, click the Save As button; then, enter the name of the
new file in the filename dialog box.

Notice that the new file LLC2 appears in the LLC2 Parameter Files list and that the
new file is selected.

Return to step 8 of “LAN Port Configuration Procedure” to complete the port
configuration process.
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LLC2 General Operating Parameters

Figure 7-17 illustrates the panel of general operating parameters for LLC2, which are the
same for all media types. Each parameter is explained in the information that follows the

figure.

Figure 7-17  LLC2 General Parameters

Maximum Number of Transmissions
Specifies the maximum number of times that a PDU is sent after the
Acknowledgment Timer, the P-bit timer, or the Reject Timer expires. It
also limits the number of times Receive Ready with P-bit set is sent when
the remote is busy and the Busy Timer expires.

The default value is 10 and the permitted range is 1 to 255.
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Maximum Number of Unacknowledged IPDUs
Specifies the maximum number of unacknowledged IPDUs that can be
received before the Reset Request acknowledging them must be sent.

The default value is 3 and the permitted range is 0 to 127.

Transmit Window Size
Specifies the maximum number of unacknowledged IPDUs that LLC
can send.

The default value is 7 and the permitted range is 1 to 127.

Transmit Probe
Specifies the position before the window is closed at which an IPDU,
with the P-bit set, is sent to ask for an acknowledgement from the
receiver.

The default value is 0 and the permitted range is 0 to 127.

Maximum Size of LLC2 I frame
Specifies the maximum size, which is equal to this sum:

maximum X.25 data size + X.25 protocol length + LLC protocol length

The default value is 263. Permitted values are: 263 to 264, 519 to 520,
and 1031 to 1032.
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LLC2 Timer Parameters

Figure 7-18 illustrates the panel of timer parameters for LLC2, which are the same for all
media types. Each parameter is explained in the information that follows the figure.
Timer parameters are expressed in tenths of a second unless otherwise noted.

1.0
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taximum Delay Before Sending RR

Figure 7-18  LLC2 Timer Parameters

Acknowledgement Timer
Specifies the time, in tenths of a second, during which the LLC expects
to receive an acknowledgement to an outstanding IPDU or an expected
response to a sent unnumbered PDU.

The default value is 1.0 and the permitted range is .1 to 300.

P-Bit Timer
Specifies the time, in tenths of a second, during which the LLC expects
to receive a PDU with the F-bit set to 1 in response to a command with
the P-bit set to 1. This value should be less than that specified for the
Acknowledgement Timer.

116



Creating an LLC2 Parameter File

The default value is .7 and the permitted range is .1 to 300.

Reject Timer
Specifies the time, in tenths of a second, during which the LLC expects
to receive a reply to a sent RE] TPDU.

The default value is 2.5 and the permitted range is .1 to 1000.

Busy-state Timer
Specifies the time, in tenths of a second, during which the LLC waits for
the clearance of a busy condition at the other LLC.

The default value is 10.0 and the permitted range is 0 to 3000.

Link Idle Timer
Specifies the time, in tenths of a second, during which the LLC expects
to receive a PDU from the other LLC. If the timer expires, the P/F cycle
is initiated, which may result in link disconnection.

The default value is 25.0 and the permitted range is 0 to 3200.

Maximum Delay Before Sending RR
Specifies the maximum delay in tenths of a second before transmitting a
delayed RR (Reset Request). This must be considerably less than the
Acknowledgement Timer value.

The default value is .4 and the permitted range is 0 to 300.
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LLC2 XID Parameters

Figure 7-19 illustrates the panel of XID parameters for LLC2, which are the same for all
media types. Each parameter is explained in the information that follows the figure.
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Figure 7-19  LLC2 XID Parameters

XID Window Size
Specifies the size of the receive window when the remote window size
is unknown or zero.

The default value is 7 and the permitted range is 1 to 127.

Duplicate MAC XID Count
Specifies the number of attempts at finding any stations with duplicate
MAC addresses. If you set it to zero, no attempt is made.

The default value is Oand the permitted range is 0 to 255.

Duplicate MAC XID Timer
Specifies the time in tenths of a second for which incoming XID response
frames are checked for a duplicate response to the station LSAP. If a
value of zero is specified, the duplicate address check is not performed.

The default value is .5 and the permitted range is 0 to 300.

These are the last LLC2 parameters. Return to step 3 of “Creating an LLC2 Parameter
File” to complete the file creation process.



Chapter 8

Troubleshooting

SX.25 provides troubleshooting information by means of the STREAMS trace and
logging utilities, and in error messages from IRIX and IRIX networking services. This
chapter provides information on each source of troubleshooting information:

¢ “STREAMS Trace Messages”
¢ “STREAMS Error Messages”
¢ “Network Board-Loading (nbload) Error Messages”

¢ “Network Daemon (snetd) Error Messages”

STREAMS Trace Messages

STREAMS trace messages can be printed out by using strace (see the trace (1M) reference
page). Without arguments, it writes all STREAMS event trace messages from all drivers
and modules to its standard output, or a subset of these when arguments are given.
Arguments define what the subset should be, and arguments must be in triplets of the
form mid, sid, level. Arguments have these meanings:

e mid is the STREAMS module/driver ID number for the module or driver
submitting the log message.

e gid is an internal sub_id number.
e Jlevel is a tracing level that allows for selective filtering of low-priority messages

from the tracer.

Each triplet indicates that tracing messages are to be received from the given module or
driver, sub_id, and priority level equal to or less than the given level. The token all may
be used for any member to indicate no restriction for that attribute.

The following modules and drivers within SX.25 currently generate STREAMS trace
messages.
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X.25 PLP Driver

Module Id 200
Sid Set to identifier of subnetwork packet tx/rx on
Levels 1-6

Six levels of tracing are available.

Trace Level 1 - Call Activity

Monitors incoming calls, outgoing calls, calls accepted, and calls connected. For each
event, a description, the subnetwork ID, LCI, and GFI are logged.

CALL In ‘65" lcn 400 gfi 5
CALL CQut ‘66" lcn 401 gfi 1
CAA Qut ‘65" lcn 400 gfi 1
CAA In ‘66" lcn 401 gfi 1

Trace Level 2 - Clear Activity

Monitors clear requests, clear indications, and clear confirmations. For each event, a
description, the subnetwork ID, and the LCI are logged. For clear requests and clear
indications, the cause and diagnostic are also logged.

CLR In ‘65" lcn 400 C/' D 0043
CLR Cut ‘66’ lcn 401 C/ D 80F2
CLC In ‘66" lcn 401
CLC Qut ‘65" lcn 400

Trace Level 3 - Reset Activity

Monitors reset indications, reset requests, and reset confirmations. For each event, a
description, the subnetwork ID, and the LCI are logged. For reset requests and reset
indications, the cause and diagnostic are also logged.

RST In ‘65 Ilcn 400 ¢/ D 0003
RST Cut ‘66" Icn 401 C/' D OOFA
RSC I n ‘66" lcn 401
RSC Cut ‘67 lcn 400
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Trace Level 4 - Restart Activity

Monitors restart indications, restart requests, and restart confirmations. For each event,
a description and the subnetwork ID are logged. For restart requests and restart
indications, the cause and diagnostic are also logged.

REST I n : 65" O D 1300
REST Qut : ‘66" C/ D 0000
RESTC In : ‘66

RESTC Qut : ‘65

Trace Level 5 - Interrupt Activity

Monitors interrupt data indications, interrupt data requests, and interrupt
confirmations. For each event, a description, the subnetwork ID, and the LCI are logged.

INT In ;65" lcn 400
INT Qut : ‘66" lcn 401
INTCIn : ‘66" lcn 401

INTC Qut : “65" lcn 400

Trace Level 6 - Data Activity

Monitors data indications and data requests. For each event, a description, the
subnetwork ID, the LCI, the send sequence number, and the receive sequence number are
logged.

DATA In : ‘65 1lcn 400 ns/nr 0702
DATA Qut : ‘66" lcn 401 ns/nr 0500

Example Trace Logging Output
# strace 200 all all

000187 16: 07: 30 0001c15b 4 . 200 67 REST In : ‘67° D 0000

000188 16: 07: 30 0001c15b 4 . 200 67 RESTC Qut : ‘67

000189 16: 08: 01 0001cf60 1 . 200 67 CALL Qut : ‘67" lci 001 gfi 1
000190 16: 08: 03 0001cf62 1 . 200 67 AR In : ‘67 lci 001 D 0900
000199 16: 08: 11 0001cfa8 6 . 200 65 DATAIn : *65 lci 43f ns/nr 0000
000200 16:08: 11 0001cfbo 6 . 200 65 DATA Qut : ‘65 Ilci 43f ns/nr 0001
000201 16:08:12 0001d5c8 3 . 200 65 RST Qut : ‘65 lci 43f 0D O0Ofa
000202 16:08:12 0001d5ch 3 . 200 65 RSC In © Y65 lci 43f
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Notes:

1. Tracing of an incoming event does not imply that the packet has been accepted by
the X.25 driver. This is because tracing of incoming events is triggered on receiving
data from the link level. At this point, the packet has still to be verified and, if in
error, may be discarded or cause some further protocol action.

2. Similarly, tracing of an outgoing event does not imply that the packet has been sent
to the link-level driver. This is because tracing of outgoing events is triggered on
requests to send data to the link level. At this point, various consistency checks are
performed on the required link-level database, and, if they fail, the packet is
discarded.

LAPB Driver

Module Id 201

Sid Set to identifier of subnetwork packet tx/rx on
Levels 1-4

Four levels of tracing are available.

Trace Level 1 - Setup and Disconnection Activity

Monitors all link setup and disconnection events. For each event, a description and the
subnetwork ID are logged. For disconnection events, an indication of whether locally or
remotely initiated is also logged.

LINK Up : *'65
LINK D : ‘66’ Renote

Trace Level 2 - Reset Activity

Monitors all link reset events. For each event, a description, the subnetwork ID, and an
indication of whether locally and remotely initiated are logged.

LINK Rst : ‘66" Local
LINK Rst : ‘65 Renote
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Trace Level 3 - Error Activity

Monitors sending and receiving of FRMR and RE]J frames. For each event, a description
and the subnetwork ID are logged. For FRMR frames, the error flag is also logged. For
RE] frames, the send sequence number in error is also logged.

FRVR In : ‘65 Err 01
FRVR Qut : ‘66 Err 08
REJ In : ‘66" N(007)

REJ Qut : ‘68 N(006)

Trace Level 4 - Busy Activity

Monitors all link busy conditions. For each event, a description, the subnetwork ID, and
an indication of whether locally or remotely initiated events are logged.

LINK Bsy : ‘65" Local
LINK Bsy : ‘66" Renote

Example Trace Logging Output
# strace 201 all all

000187 16:07:30 0001c15b 1 ... 201 65 LINK Up : ‘65

000188 16:07:30 0001c15b 1 ... 201 65 LINK Dan : ‘65 Local
000189 16:08:01 0001cf60 3 ... 201 65 FR\RIn : ‘65 Er 01
000190 16:08:03 0001cf62 2 ... 201 65 LINK Rst : ‘65 Renote
000197 16:08:06 0001cféc 3 ... 201 65 REJ Qut : ‘65 N 006)
000198 16: 08: 06 0001cfa7 4 ... 201 65 LINK Bsy : ‘65 Local

Notes:

1. Tracing of an incoming event does not imply that the frame has been accepted by
the LAPB driver. This is because tracing of incoming events is triggered on
receiving data from the WAN. At this point, the frame has still to be verified and, if
in error, may be discarded or cause some further protocol action.

2. Tracing of an outgoing event implies that the frame has been sent to the WAN
driver. It does not imply that the frame will be transmitted on the line.
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LLC2 Driver

Module Id 202

Sid Set to identifier of subnetwork packet tx/rx on
Levels 1-5

Five levels of tracing are available.

Trace Level 1 - Setup and Disconnection Activity

Monitors all link setup and disconnection events. For each event, a description, the
subnetwork ID, and the connection identifier are logged. For disconnection events, an
indication of whether locally or remotely initiated is also logged.

LINK Up : “C 1d 001
LINK Dwn : ‘C 1d 002 Renpte

Trace Level 2 - Reset Activity

Monitors all link reset events. For each event, a description, the subnetwork ID, the
connection identifier, and an indication of whether locally or remotely initiated are
logged.

LINK Rst : ‘68 |d 001 Local
LINK Rst : ‘67" |Id 021 Renpote

Trace Level 3 - Error Activity

Monitors sending of FRMR and RE] frames. For each event, a description, the
subnetwork ID, the connection identifier, and an indication of whether locally or
remotely initiated are logged. For FRMR frames, the error flag is also logged. For RE]
frames, the send sequence number in error is also logged.

FRMR In : “67 1d 010 Err 01
FRVMR Qut : ‘68 1d 009 Err 08
REJ In © "67° 1d 010 N(007)
REJ Qut : '67 1d 023 N(006)
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Trace Level 4 - Busy Activity

Monitors all link busy conditions. For each event, a description, the subnetwork ID, the
connection identifier, and an indication of whether locally or remotely initiated are
logged.

LINK Bsy : ‘67" 1d 012 Local
LINK Bsy : ‘67" |Id 013 Renpte

Trace Level 5 - Type 1 Activity

The following type 1 events are monitored: sending and receiving of XID and TEST
frames. For each event, a description, the subnetwork ID, and the connection identifier
are logged.

TEST Qut : ‘67 |d 000
XIDIn : *67 1d 013
XID Qut : ‘67 1d 013

Example Trace Logging Output
# strace 202 67 all

000186 16: 07: 27 0001c150
000187 16: 07: 30 0001c152
000188 16: 07: 30 0001c15b
000189 16: 08: 01 0001cf 60
000190 16: 08: 03 0001cf 62
000197 16: 08: 06 0001cf6C
000198 16: 08: 06 0001cfa7

202 67 XID Qut : ‘67 1d 001

202 67 LINK b : ‘67 1d 001

202 67 LINK Dan : 67 1d 010 Local
202 67 FRMRIn : ‘67 1d 038 Er 01
202 67 LINK Rst : *67 1d 231 Renote
202 67 REJ Qut : ‘67 1d 128 N 006)
202 67 LINK Bsy : ‘67 1d 007 Local

A OWONWERRFOG

Notes:

1. Tracing of an incoming event does not imply that the frame has been accepted by
the LLC2 driver. This is because tracing of incoming events is triggered on receiving
data from the Ethernet level. At this point, the frame has still to be verified and, if in
error, may be discarded or cause some further protocol action.

2. Tracing of an outgoing event implies that the frame has been sent to the Ethernet
driver. It does not imply that the frame will be transmitted on the Ethernet.
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Tracing Summary

Table 8-1 shows the available tracing levels for the three types of drivers:

Table 8-1 Tracing Levels
Level X.25 Driver LAPB Driver LLC2 Driver
ID 200 ID 201 ID 202
1 Call Setup Link Up/Down Link Up/Down
2 Call Clearing Link Reset Link Reset
3 Call Reset Error Activity Error Activity
4 Restart Activity Link Busy Link Busy
5 Interrupt Packets - Type 1 Activity
6 Data Packets - -

STREAMS Error Messages
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STREAMS error messages can be captured using strerr (see the strerr (1M) reference
page). This receives error messages and appends them to an error log file. This utility is
normally run when the system initializes to multiuser state.

The following types of errors are logged:

System errors  Errors in the internal workings of the module/driver.

Reference errors
Errors in the references used between upper and lower
modules/drivers

Interface errors Errors in messages passed over the interfaces.

Allocation errors
Errors in the allocation of memory for database elements.

The X25 PLP driver, the LAPB driver, and the LLC2 driver of SX.25 currently generate
STREAMS error log messages.



Network Board-Loading (nbload) Error Messages

Network Board-Loading (nbload) Error Messages

Error <reason> in GETDET conmand

The specified board could not be opened for loading, for the reason stated in
<reason>. For example, a board has been configured but is not present.
Reconfigure the boards using x25adm ipconfig and x25adm x25config.

Error <reason> i n EXECUTE comrand - |ine <lineno> of /var/opt/snet/brdconf

The program downloaded to the board could not be executed, for the reason
stated in <reason>. The board can be identified by referring to line number
<lineno> in /fetc/brdconf. This error may be due to a board crash. Reboot the
system.

nbl oad: Invalid address for X 25 (WAN) board on |ine <lineno> of
/var/opt/snet/brdconf

An address has been configured for use on an X.25 (WAN) board. This field
should be null. Reconfigure the board using x25adm x25config.

Network Daemon (snetd) Error Messages
attenpt to nultiplex nmodul e <module>
bad for mat
The /etc/config/snetd.options file is not in the expected format. Configure the
network parameters using x25adm.
ECHO TYPE ioctl fail ed: <reason>

The Echo/Ethernet registration failed. This may be due to an incorrectly
configured Ethernet card.

Reconfigure the Ethernet card.

failed to open <file>: <reason>

The configuration file <file> (default:/etc/config/snetd.options) could not be
opened, for the reason stated in <reason>. The configuration of the Internet
address and other network parameters has not been successfully completed.

Configure the network parameters.
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failed
failed
fail ed
failed
failed

to open driver <driver>: <reason>

The lines referring to the driver <driver> in the /etc/config/snetd.options file are
wrong. The operation failed for the reason stated in <reason>. Configure the
network parameters.

to open Ethernet Driver: <reason>

The Ethernet driver could not be opened, for the reason stated.

t o open stream <stream>: <reason>

The lines referring to the stream <stream> in the /etc/config/snetd.options file are
wrong. The operation failed for the reason stated in <reason>. Configure the
network parameters.

to link stream <stream> under driver <driver>. <reason>

The lines referring to the stream <stream> in the /etc/config/snetd.options file are
wrong. The operation failed for the reason stated in <reason>. Configure the
network parameters.

to push nodul e <module>: <reason>

The lines referring to the module <module> in the /etc/config/snetd.options file are
wrong. The operation failed for the reason stated in <reason>. Configure the
network parameters.

I _PUSH ( <module>) : <reason>

The kernel module <module> could not be pushed onto a stream, for the reason
stated in <reason>.

| P_NET_ADDR ioctl failed

The Internet address, subnet mask, and other parameters on the IP_NET line in
the /etc/config/snetd.options file have not been correctly configured. This error may
also be given if more IP-IXE lines have been configured in the
/etc/config/snetd.options file than are configured in the IXE kernel. This error can
only occur if you also have SGI TCP in your network.

Reconfigure the network parameters for this IP network.



Network Daemon (snetd) Error Messages

| XE_SNREG i octl failed

This failure is due to IXE being incorrectly configured. For example, an IP
address referring to an IP-IXE link in the /etc/config/snetd.options does not match
the address in the /efc/ixetuneconf file.

Reconfigure IXE correctly.

nmust specify ‘d or ‘m flag
One of the flags in a line at the top of the /etc/config/snetd.options file declaring the
name of a driver, cloneable driver, or a module is not valid.

no driver bel ow nodul e <module>

unknown nodul e <module>

The lines referring to the module <module> in the /etc/config/snetd.options file are
wrong.

Configure the network parameters.

unexpected delimter
The /etc/config/snetd.options file is not in the expected format.

Configure the network parameters.

non nuneric instantiation
The explicit association of multiple instances of a module in the
/etc/config/snetd.options file has a non-numeric label.

out of menory
There is insufficient memory for the data structures required to start the
network.

unknown control action: <reason>
The file /etc/config/snetd.options contains a line with the unknown registration
message <reason>

<parameter> ar g count (number) w ong!

The number of arguments to the parameter <parameter> in the
Jetc/config/snetd.options file is incorrect.

Configure the network parameters.
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war ni ng: ignoring <flag> flag

One of the flags in a line at the top of the /etc/config/snetd.options file declaring the
name of a driver, cloneable driver, or a module is not valid.

‘ 1

war ni ng: assuming ‘c’ flags neans driver

One of the flags in a line at the top of the /etc/config/snetd.options file declaring the
name of a driver, cloneable driver, or a module is not valid.

warning: ‘m flag ignored for driver

One of the flags in a line at the top of the /etc/config/snetd.options file declaring the
name of a driver, cloneable driver, or a module is not valid.

warning: ‘c’ flag ignored for

One of the flags in a line at the top of the /etc/config/snetd.options file declaring the
name of a driver, cloneable driver, or a module is not valid.



Appendix A

Address Formats

X.121 Addresses

X.25 addresses are X.121 DTE strings that contain a maximum of four fields. The format
of the address depends on the type of network and the version of X.25 recommendation
that the network uses. Table A-1 illustrates X.121 address formats.

Table A-1 X.25 Network Address Formats

Network Type  X.25 Version Address Formats

LAN 1984 and 1988 id.LSAP
id.LSAP[.N].OSI NSAP
id.LSAP.X.non-OSI address extension

WAN 1980 id.DTE

id.LCLP (for permanent virtual circuits)

1984 and 1988 id.DTE[.N].OSI NSAP
id.DTE.X.non-OSI address extension
id.LCLP (for permanent virtual circuits)

The fields in the previous address formats have these meanings:

id is a single-character (alphanumeric) subnetwork identifier. This
identifies a connection to or from the WAN or LAN.
DTE defines the Subnetwork Point of Attachment (SNPA) for each WAN line.

This is entered as an address of up to 15 decimal digits; or, for X.25(88)
TOA /NPI addresses, a maximum of 17 decimal digits.

LSAP defines the SNPA for each LAN line. It comprises the MAC address plus
the DSAP address, 14 hexadecimal digits in all:
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The MAC address is a unique 12-digit address identifying hosts and
devices on the Ethernet; it is also called an Ethernet address. An MAC
address looks like this example:

08004e011£37

The DSAP address is the Destination Service Access Point, which is a
two-digit address indicating the destination Link Layer service access
point.

Nor X is an indicator that identifies the next part of the address as either an OSI
NSAP address or a non-OSI address extension.

OSI NSAP is the Network Service Access Point, the point at which the Network
Service is provided. The NSAP address can be up to 40 hexadecimal
digits.

non-OSI address extension
indicates that the given address (up to 40 hexadecimal digits) is encoded
in the X.25 Call Request packet as an “eXtended” address, that is,
non-OS], as opposed to an NSAP address (OSI).

LCI is the logical channel identifier, three hexadecimal digits. Pad in front
with zeroes if necessary, for example, enter “009” rather than “9”. (The
“P” that follows indicates that the LCI describes a permanent virtual
circuit.)

Internet Addresses

An Internet address has 32 bits. It can be thought of as containing four fields, each
ranging from 0 to 255 (decimal). The four fields are usually represented with “.” field
delimiters. An Internet Address can be represented as decimal, octal, or hexadecimal:

¢ Decimal addresses have no prefixes and may not begin with zero. An example is
“83.0.0.127”.

®  Octal addresses begin with a zero. For example, “83.0.0.127” in decimal is
“0123.0.0.177” in octal.

* Hexadecimal addresses are preceded by the Ox or 0X prefix. For example,
“83.0.0.127” in decimal is “0x53.0x0x0x7E".
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CCITT
International Consultative Committee for Telegraphy and Telephony.

CONS

Connection-Oriented Network Service.

DCE
Data Circuit-Terminating Equipment.

DDN
Defense Data Network.

DNIC
Data Network Identification Code.

DSAP

Destination Service Access Point.

DTE

Data Terminal Equipment. The user equipment (computer, terminal, etc.)
connected to a network.

Ethernet

Ethernet, or IEEE 802.3, is a network based on an access method called
CSMA /CD. Ethernet was originally developed by the Xerox Corporation in
1972. A specification was published in 1980 for other implementors to use.

Ethernet Address

A 48-bit station identifier. Each network node has a unique address. The
high-order bytes are usually manufacturer-specific. Certain reserved
addresses have special meaning.
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getty
A process that handles incoming calls.

IEEE

Institute of Electrical and Electronic Engineers.

Internet Address

A 32-bit address used to identify nodes on the network that use the Internet
Protocol.

ISO

International Organization for Standardization.

IXE
IP to X.25 Encapsulation.

LAN

A Local Area Network, where several hosts and devices are located near
each other and connected physically by cables. Typically, these cables are
Ethernet coaxial cables.

LAP
Link Access Procedure.

LAPB

Link Access Procedure - Balanced.

LCI
Logical Channel Identifier.

LLC
Logical Link Control.

LLC-2
Logical Link Control - Class II.

LSAP

Link Service Access Point.
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NLI
Network Layer Interface.

NSAP
Network Service Access Point.

osl
Open Systems Interconnection.

Packet

Units of information that contain a header with addresses and handling
information and a message. Longer messages can be split up into several
different packets and sent separately.

PAD

Packet Assembler/Disassembler. A means of interfacing a character
terminal to an X.25-based network.

PDU
Protocol Data Unit.

PVC

Permanent Virtual Circuit.

RFC

A “Request for Comment” discussion document, produced by interested
parties, which may be adopted as a standard by the Internet Activities
Board.

RPOA
Recognized Private Operating Agency.

SNPA
Subnetwork Point of Attachment.

SSAP
Source Service Access Point.
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STREAMS

A set of system calls, kernel resources, and utility routines that create, use,
and dismantle a stream.

Subnetwork

In this document, this term refers to a single physical DTE/DCE link or a
single physical Ethernet link.

TOA/NPI

Type Of Address / Numbering Plan Identification. An address format that
provides increased addressing capacity suitable for communication with
ISDNSs.

VC
Virtual Call.

WAN

Wide Area Network. Computers with long distances between them
connected by, for example, telephone lines.

X.25

The CCITT recommendations covering network access protocols for ISO
layers 1, 2, and 3 made in 1980, 1984, and 1988.

X.3, X.28, X.29

The CCITT recommendations covering PAD operation made in 1980, 1984,
and 1988.
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DTE, 131 link level (X.25 level 2 protocol), 6

DTE address, 6 LLC-2 driver, 124,125
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localization, 101

logical channel, 3

logical channel identifier, 120, 132
logical channel number, 3
loopback ports, 34

LSAP, 131

M

M-bit, 57,92
Modulo 128, 87,91, 92,109
Modulo 8, 87,91, 92, 109

N

Network Service Access Point, 132
network user address, 2

NSAP address, 132

NSDU length, 92

NUA, 2

Number of Transmissions, 108, 114

P

packet level (X.25 level 3 protocol), 6
packet level protocol, 6

packet size, 91,97, 105

P-bit, 110, 116

permanent virtual circuits, 1, 3
Permissions file, 81

physical level (X.25 level 1 protocol), 6

PLP, 6
port (definition), 6
Priority Packet Forced Value, 103
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PVC, 3

R

Reject Timer, 111,117

S

snetd program, 127

Source Address Control, 102
strace utility, 119

strerr utility, 126

subnet ID, 6

subnet mask, 56
subnetwork ID, 120, 131
subnetwork modes, 101
Subnetwork Point of Attachment, 131
SVC, 3

switched virtual circuit, 3
Systems file, 81

T

TCP/IP, 128

TELENET, 98, 105
TEST frames, 125
throughput class, 3,105
timer parameters, 92
Transmit Probe, 109, 115
troubleshooting, 119

U

UUCP configuration, 79
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virtual calls, 1
virtual circuit, 3
virtual circuits, 9

W
WAN driver, 123
window size, 3,91, 109, 115

X

X.121 string, 131
X.25 PLP driver, 120
X.25 Version, 87
XID frames, 125
xty device driver, 79
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As a user of Silicon Graphics documentation, your comments are important to us. They
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documentation.

Any information that you provide will be useful. Here is a list of suggested topics to
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* General impression of the document

*  Omission of material that you expected to find

* Technical errors

¢ Relevance of the material to the job you had to do

¢ Quality of the printing and binding

Please include the title and part number of the document you are commenting on. The
part number for this document is
007-2179-003.
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The postcard opposite this page has space for your comments. Write your comments on
the postage-paid card for your country, then detach and mail it. If your country is not
listed, either use the international card and apply the necessary postage or use electronic
mail or FAX for your reply.
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e If you are on the Internet, use this address: techpubs@sgi.com

e For UUCP mail, use this address through any backbone site:
[your_site]!sgiltechpubs

You can forward your comments (or annotated copies of pages from the manual) to
Technical Publications at this FAX number
415 965-0964.



